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EnterpriseIQ is a windows operating environment which uses drop down menus, icons, and toolbars to 
access and navigate through the various screens and records containing the EnterpriseIQ data. This 
section provides an introduction to the EnterpriseIQ program, and discusses how to launch the program 
and to navigate using the menu and toolbar functions. 
 

Using EnterpriseIQ - Basic Functions 
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Launching the EnterpriseIQ Program 

Launching the Program 

The EnterpriseIQ program is accessed from the EnterpriseIQ Program Folder by selecting the 
EnterpriseIQ executable. The DELMIAworks Logo will flash on the screen followed by a prompt to log 
onto the system. Enter your User Name and Password. 

Please Note: Typically the DB Alias (database alias) is set to IQORA unless otherwise specified. You may 
also have a test database called IQTest or IQTrain for use in testing procedures without corrupting live 
data. For more information on using other databases, please contact support at 
DELMIAWORKS.SUPPORT@3ds.com. 

The system will verify the User Name and Password, and the EIQ Launcher Bar will appear on your 
screen. All EnterpriseIQ modules are launched from this tool bar. Therefore, the Launcher must remain 
on your screen at all times—although it can be minimized. Closing the Launcher will close all 
EnterpriseIQ modules. You will be required to log back onto the system to gain access to the applications 
once again. 

Note: Users are able to login when entering a space before or after their password due to how Oracle 
handles passwords 

Note: If a user has been assigned a 'WebIQ User' license (in WebIQ) they will not be able to log into 
EnterpriseIQ. An error will display stating, "This is a WebIQ user only". 

When closing the EIQ Launcher any open BDE sessions that are created when launching external apps 
are also closed. It is possible to cause a BDE error if you launch enough BDE sessions to hit the 48 session 
limit. 

For companies that have multiple EPlants, when users log in they will automatically be logged into their 
default EPlant established in the Security Inspector. If no default is established they will be logged in as 
view all. To change the EPlant you are logged into select File->Login->Enterprise Plant from the launcher 
bar.  
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Select the One Plant option and select the EPlant from the drop down list. Only the Accessible EPlants 
listed for the user in Security Inspector plus their default EPlant will be available to choose from. If there 
are no Accessible EPlants associated to the user they will be allowed to login to all of them. 

Selecting Menu Items 

All functions, screens, and reports are accessed from the EIQ Launcher Bar. The launcher is a floating tool 
bar which provides access to all screens used to manipulate and display data. The top blue bar will 
display in parenthesis the DB Alias, EPlant, and native currency if applicable. If the Password Policy 
options in Security Inspector for 'Display User ID on Launcher' and 'Display Last Login' are checked the 
user ID and last login date/time will also display on the Launcher Bar. The background color of the 
launcher bar can be changed for each EPlant (Sys Setup->System Parameters->Enterprise tab-
>Miscellaneous tab). 
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Accessing a module is done by highlighting the appropriate tab (Mfg, RealTime, GL, AR, etc.) and then 
clicking on the button associated with the selected option. Alternatively, all modules can be accessed 
from the drop down File menu. Also available from the File menu are the ten most recently used items 
from the BOM, Inventory, RFQ, and Sales Order modules. When logged into an EPlant the system stores 
the last 10 EPlant specific forms visited. When logged into View All it will display last 10 forms visited 
within all EPlants. 

To learn more about the function of each button on the EIQ Launcher Bar, place your mouse on the tool 
bar item and a brief hint will appear explaining the function. 

NOTE: Not all options are graphically represented on the EIQ Launcher Bar. Modules that are seldom 
used, or used only during setup, are not displayed as icons on the Launcher. These options are located 
under the main menus displayed across the top of the EIQ Launcher Bar. Your system may not show all 
options, as shown on the previous graphic. If certain modules were not purchased as part of your 
system, they will not be represented on the launcher. Also, you can use the security system to limit what 
is shown on the launcher bar. This can be used to fine tune the features a particular user might need, 
without showing other modules that are not appropriate. 

New EIQ Session 

A new EIQ Session can be opened by selecting this option from the File menu. A confirm box appears 
asking, "This option spawns new EIQ session based on logged in user credentials. Do you wish to 
continue?" After selecting Yes, the user can select the EPlant. Security can be placed on this form so that 
the default EPlant is set to One plant and not view all. Note: In order for this to work correctly the 
security must take away ‘Visible’, if the security just has enable taken away it will still default to ‘View 
All’. Note: Using this option does not consume an additional license. 

Most Recently Used 

On the File menu of the launcher bar the ten most recently visited places will be displayed. This is EPlant 
specific, not user specific. This applies to BOM’s, inventory items, quotes, purchase orders, and sales 
orders. Click on the item in the list to quickly access the record. 

Data Navigators 

Almost all screens include the ability to add, edit or scroll through data records. These screens all display 
a common navigator toolbar. This toolbar allows easy manipulation of data, from adding, to editing, to 
deleting records. Once you understand how the toolbar behaves, you will know how all records in 
EnterpriseIQ are managed. 

Toolbars and Menus 

Most screens contain a menu and a tool bar containing various options. To learn more about the 
function of each button on the tool bar, simply place your mouse over the tool bar item and a brief hint 
will appear explaining the function. 

The menus contain access to the basic options available on the screen. These include adding new records 
(which can also be accomplished from the Navigator), printing reports, selecting various options, or 
accessing related tables. 

Quick Jumps 
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Within many of the modules, jumps are available to quickly access other screens that contain related 
data. For example, while in the order entry screen, quick jumps to the inventory record for that item are 
available with a single right click of the mouse. Jumps are possible whenever the “jumping man” is 
attached to the cursor. When this occurs, right click the mouse button and all available jumps will be 
shown. 

EIQ Jump Bookmark 

Certain modules (such as: BOM, Purchase Orders, Sales Orders, Inventory, RFQ, Work Orders, Customer 
Maintenance, Vendor Maintenance, AP and AR Posted Invoices, Project Manager, and PLM or DHR) have 
an option to create an EIQ Bookmark. This option allows the user to drag and drop the icon onto the 

desktop or a folder in order to open the exact record up again with one click. Select the  EIQ 
Bookmark button on the desired record. Then drag it to the desktop or folder and drop it. The shortcut 
will be named after the module and record id by default. For example, if you create a bookmark for a 
BOM it will be called ‘BOM_#####.eiq’, with the number being the ID from the Standard table. An EIQ 
bookmark can be renamed like any file, but you must keep the eiq extension. 

When you open the bookmark at a later time the user must log into the same EPlant or View All. 

Note: In order for the EIQ Jump feature to function check the "Associate bookmark files (.EIQ) with 
EnterpriseIQ" check box on the Bookmarks page in IQStatus, then select the Apply button. 

Note: On the EIQ bookmark from the PLM and DHR web approval page, jump to the linked quote and 
create a bookmark from there. The Source of the quote must be RFQ and Source Description must be 
completed as assigned for the icon to be activated. 
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IQExtension Setup 

The IQExtension Setup option allows the user to add additional programs to the main launcher bar or 
Smart Page Extensions for easy access. This is used to support the client execution of systems such as 
Crystal or EIQ Extended modules such as ShopData and custom exes. The IQExtension Setup option 
stores the global path to call the executable as well as the icon to use on the launcher. Only a DBA can 
make these changes. The button(s) added will be visible to all users based on security.  

This can also be used to enter user defined scripts to be run from an icon on any of the launcher bars or 
from a shortcut in Smart Page.  

Select the IQExtension Setup button on the Sys Setup tab . The following form will appear: 
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The Type field is used to determine the type of extension. Choose either Exe or Script. 

Exe Type 

To enter an Exe Type extension, select the ADD (+) button and then select 'Exe' from the Type drop 
down. Click in the Executable Path / Script Description field. Select the ellipsis button and browse to the 
program to be added. Environment variables are allowed so that applications like Chrome can be reused. 
(For example: %LocalAppData%\Local\Google\Chrome\Application\Chrome.exe). 

 Designate which of the tabs the extension exe icon should be on using the drop down list in the 
Launcher Tab Name field. One of the options is EIS (Executive Information Systems). If EIS is selected a 
new tab will appear on the launcher bar called EIS. 

The IQMS Program box should only be checked for custom IQMS programs that are run from the local 
home, this is not designed to launch standard EIQ modules such as IQCRM. For these modules, when the 
box is checked the user will not have to log into the extended program again. (If there is a question 
about the whether the box should be checked, please contact Support at 
DELMIAWORKS.SUPPORT@3ds.com). If the IQMS Program box is checked the system will remove the 
path and just store the exe name. If the IQMS Program box is checked for a module that is not run within 
EIQ the user will receive an ‘Invalid Class String’ error but can still continue to log in and run the 
extended program. 

Note: Running any exe (IQMS or other) from the EIQ Launcher Bar will use an EIQ license because the EIQ 
program must launch first. 

Next, enter text into the Hint field that describes the program. When the user mouses over the button on 
the tab, this hint will display. 

The Optional Parameters field is a 255 variable character field used for in-line parameter(s). This can be 
used if you are running an .exe that can allow for parameters; i.e. some programs can be run in a DEMO 
mode. If this applies, enter the optional parameters by typing in the field otherwise leave it blank. 

Continue this process until all of the desired programs have been added. 

Script Type 

To enter an Script Type extension, select the ADD (+) button and then select 'Script' from the Type drop 
down. Note: Only Power Users and DBAs can access the script setup form. Enter a Script Description in 
the Executable Path / Script Description field. Select the Launcher Tab Name from the drop down list 
where you want the icon to reside, then select the ellipsis button in the Script Description field and the 
Ad Hoc Editor form will appear: 



Using EnterpriseIQ - Basic Functions Page 10 of 134 

 

 



Using EnterpriseIQ - Basic Functions Page 11 of 134 

 

The script name will appear at the top. Enter the SQL Expression in the white space. The system is 
looking for a colon (:) in the SQL, as the text following the colon creates the parameter name once the 
‘Refresh Parameter List’ is clicked on. 

Select the 'Refresh parameter list' button  to update the Parameters section with parameters from 
the script. Select the appropriate Data Type (Numeric, Char, or Date) from the drop down for each 
parameter, and enter the Display Label that will be visible when executing the SQL. 
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The Value field is used to enter a user defined look up list that users can select from when running the 
script. To enter the list select the ellipsis button and enter the # and Value for all values that you want to 
apply to the parameter. 

 

Select the Validate Syntax button  to ensure the SQL will run. If it is OK a message will appear 
stating, "Finished validating SQL expression - no errors reported". If there are parameters the value field 
cannot be null or an error will appear stating the value is not valid after selecting the Validate Syntax 
button.   

Once the script is set up users can access it from the icon on it's selected launcher tab. The hint for the 
button will be the text entered in the Hint field in the IQExtension set up form. 

 



Using EnterpriseIQ - Basic Functions Page 13 of 134 

 

After selecting the button the Ad Hoc Query form will appear. Enter the parameter values using the drop 
down lists, or manually enter a value.  

 

Click on the 'Execute SQL' (lighting button) to view the results. 
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The results can be exported as a .xls or .xml file by selecting an option from the Export button. 
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Launcher Bar Functions 

Options Menu: 

StayOnTop Option 

The EIQ Launcher Bar can be programmed to remain on top of the module(s) that you are working in. 
This enables you to complete work in other modules without having to back out each time. 

➢ Select Options from the menu bar. 

➢ Choose StayOnTop from the submenu. 

Multiple Tabs 

You can easily move the tool bar around to any location or resize it to fit the screen. If you find that you 
cannot view all of the tabs on the Launcher, click on the Multiple Tab option. This will enable you to see 
all tabs available from the EIQ Launcher Bar.  

 
To disable either feature, simply follow the same steps as mentioned on the previous page for applying 
this feature. 

Open Forms 

Use this option to display a list of modules (forms) currently open on your desktop. This is very handy 
when you have many forms on the screen and you want to get to one of them quickly. Simply highlight 
the form you are interested in and double click. Your form is brought to the surface for continued 
editing. 

Note: If a user tries to open more than 10 instances of the same form an error generated by the EIQ 
security system will appear. The error will be slightly different depending on the module. For example, in 
Purchase Orders, with 10 purchase orders opened and minimized, when the user tries to open the 11th 
PO the following error will occur: ‘General SQL error. ORA-01000: maximum open cursors exceeded SQL 
expression: select count(*) from eplant Alias: IQ.’  

Dialog Check Boxes  
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Dialog check boxes are used to specify if you want certain messages in the software to show or not. To 
have the message show, click the show box. If you do not want to see the message, un-check the box. 
This can also be accessed from the Options menu on the launcher bar. 

Note: After updating EIQ to a new version this form may appear blank until the area of the software 
where a 'Confirm message' appears or would appear has been accessed. The 'Show' setting is 
remembered. This option is also available in System Parameters->Lists menu. 

My Alerts 

From the My Alerts tab in Security Manager, actions can be assigned to users to enable them to execute 
the alerts from the My Alerts menu option on the EIQ Launcher Bar or in Smart Page. When the user 
selects 'Execute...' from the My Alerts menu the Alert form will display with their actions listed. Users will 
be able to execute their actions by clicking on the Execute Action Now! button or right click and select 
the 'Execute Action Now!' option. From My Alerts users will only have the ability to execute their alerts 
and view the Exception Log (File menu). A password is not needed to close My Alerts. 
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My Workflows 

My Pending Approvals  

Select My Pending Approvals to access your pending approvals. This will include approvals required for 
all modules that use the workflow functionality such as PO Approvals, Document Control and other 
quality modules, as well as IIS Server based approvals for Expense Reports and Document Certification 
Training. From this screen the user can select an item to review by clicking on the link. 
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Out of Office Workflow Routing 

Select this option to make Out of Office adjustments on the logged in user's workflow records. This only 
applies if the logged in user is a Team Member. This allows the team member to handle their own out of 
office settings eliminating the need for an administrator to go in and mark a team member out of office. 
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This form will list the modules where the team member is responsible. Select the delegate from the pick 
list accessed by clicking on the ellipsis button in the Delegate Name field. Only the team members used 
in that module will be available to choose from. On the responsibility tab for all open workflows the 
system will replace the principal with the delegate, and the principal will become the delegate. Newly 
opened workflows will have the delegate on the element responsibility lines with the principal as the 
delegate. Security is available for this option. 

To mark yourself as out, check the 'Out Of Office' box and select the post record check button. A warning 
will appear stating, "Team Member [Name] is marked as 'Out Of Office'. Start redirecting [Name] 
workflows to designated delegates?" Once Yes is selected the team member will be highlighted in yellow 
and the system will send an email to both the Principal and Delegate with the following information: 
“Notice that [principal] will be out of the office. [delegate] will be processing [module] workflows in 
[principal’s] absence. Thank you.” 

On the responsibility tab for all open workflows the system will replace the principal with the delegate, 
and the principal will become the delegate. Newly opened workflows will have the delegate on the 
element responsibility lines with the principal as the delegate. 

When the team member is no longer out of the office, un-check the box and a warning will appear 
stating, "Team Member [Name] status 'Out Of Office' is about to be canceled. Stop redirecting[Name] 
workflows to designated delegates?" Select Yes and the system will send an email to both the Principal 
and Delegate with the following information: “Notice that [principal] has returned to the office. 
[delegate] will no longer receive [module] workflows intended for [principal]. Thank you.” The system 
will replace the delegate with the principle on the responsibility tab for all open workflows. 
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Common Form Functions 

Many of the forms within EnterpriseIQ look and behave in a consistent manner. The next sections 
describe the common features you will find on most forms. Learning how these features work once will 
increase your ability to use other forms quickly and efficiently. 

Basic Page Structure 

Typical forms include the following: 

▪ Title Bar - The top bar of a module displays the module name and specific record details, such as 
Sales Order ### for Customer XXX. 

▪ Menu Drop Down - Most forms include a menu with drop down options. 

▪ Speed Buttons - Each form will include speed buttons to access relevant functions. 

▪ Multiple sections - Forms will often have multiple sections (header, and details). Each section will 
typically have it's own navigator bar. 

▪ Right Click - Most forms have options available from a right click menu. Forms that do not include a 
EIQ right click menu will often have the standard Windows right click options such as cut/copy/paste. 
In Windows 7 and Vista there will also be: Right to left reading order and Show/Insert Unicode 
control characters. 

Due to a Microsoft mandate the following change is in place throughout the software regarding right 
clicks in forms.  A user can no longer be focused on a field and right click to jump, etc., the user must 
right click on the field label or near it, depending on the form, to get the right click menu.  Otherwise 
users will see the Windows right click menu with Cut, Copy, Show Unicode.  This is how it is now with 
all software that is Unicode compatible.  So for example, if you are in Customer Central and want to 
jump to the customer, click in the gray area next to the word Company, but not within the Company 
field.  On a grid, it depends on the field type whether you can right click within the grid or the field label 
above the grid.   

▪ Jumping Man (right click) - Many modules will have right click jump to features to access relevant 
areas of the system. If there are 'Jump To' options available the cursor will usually display a 'jumping 

man' . 

▪ Drill Down (left double click) - Several forms will include drill down capability. This allows users to 
drill down to see the details that make up the current record. When this is applicable the cursor will 

display a 'drill' . 

Columns 

The columns in forms can be resized and moved similar to a spreadsheet. To move a column drag the 
column header with the mouse to the desired position. 
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To resize a column drag the column borders smaller or larger. 
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Once columns are moved and/or resized they will remain that way for the specific user until a version 
update is performed and the forms are reset to default. 

Note: If a form is changed and the user opens another record of that same form, the columns will be in 
default order. When all forms are closed and a single record is opened the columns will be in the order 
and size based on the user's settings. 

Ellipsis Button Fields 

Several fields in the system include an ellipsis button to access the form or pick list related to the field. 
Users can click on the ellipsis button with the mouse, or select the Alt+Down Arrow keyboard buttons to 
open the form/pick list. For example, if the field accesses a pick list of account numbers users can tab to 
the field, select Alt+Down Arrow, type the account number, then hit enter twice. 

ALT F1 and ALT-Left Click Hot Keys 

The ALT-Left Click and/or ALT-F1 hot key functionality is available in many fields throughout the system 
to display the table name or SQL behind the data aware components on forms. Different components 
will surface different level of details, for instance some will show the associated column in the SQL and 
others will only display the Query or table behind it. Below is an example of the information that 
surfaces when clicking a hot key on the Customer field on a packing slip. 
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The Menu 

At the top of each screen there is a Menu and Navigator bar (as shown below). The menus contain 
access to all related options within a module. The speed buttons provide quick access to related areas 
without having to use the drop down menu functions. 

 

The functions within a Menu will vary from form to form, but the manner in which you access their 
features is consistent. The above example is from the Customer Module, and shows several typical 
headings - Customer, Options, Reports and Help. 

Various commands can be chosen from the menus contained within the menu bar. To choose a 
command, point on the menu name, hold down your left mouse button, move the pointer to highlight 
your choice, and release the mouse button. 

Below lists menu items and speed buttons found on almost every form within EnterpriseIQ. 
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Navigator Bar 

The Navigator Bar is used to manage information in a data Table. Functions include moving between 
records, deleting records, creating records, posting changes, etc. As previously mentioned, the menu bar 
differs slightly from screen to screen, but the Navigator bar will always remain the same and will always 
be located in the upper right section of the Tool bar. 

The functions on the Navigator bar are described below: 

Beginning of File 

 Places the cursor at the beginning of the record list. 

Previous 

 Scrolls back to the previous records one at a time. 

Next 

 Advances forward to the next record. 

End of File 

 Places the cursor on the last record. 

Insert/Add 

 Allows the user to add in new records. 

Delete 

 Deletes the current record. 

Edit Record 

 Allows the current record to be edited (this function will only be seen occasionally throughout the 
EnterpriseIQ program as most modules are already in the ‘edit’ mode). 

Save Changes 

 Saves changes made to the current record. There may be times when the system will not allow you 
to save the changes until a mandatory field is populated. Fields can be marked as Mandatory in Data 
Dictionary which will require users to populate a field before being allowed to post the edit. For 
example, in a BOM, if the Max WO Batch Size field is marked mandatory and the user does not enter a 
value in the field, when they select the save changes button they will be given an option to abort 
changes yes or no, so the entered data is not lost.  In customer maintenance, for example, when 
creating a new customer when saving the changes and there is a missing mandatory field, the only 
option is to click OK but what was entered remains on the screen and the user can fix the missing field. 

Cancel Changes 
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 Cancels any changes made to the current record and reverts to the saved record. 

Refresh 

 Updates the information after editing or adding. If information entered does not show up on the 
screen, click this button to refresh the database. New data should appear. 

In many cases, these functions can be accessed from the tool bar, or by using the drop-down menu 
options. 

For example, the Customer File menu menu allows you to do the following: 

▪ New Create a new customer 

▪ Delete a customer record 

▪ Search for a particular record 

▪ Status Takes you to the customer status form 

▪ New Customer Template - opens the template form 

▪ Toggle Table/Form View to Form or Table layout 

▪ Close the module 

Note: As forms are resized the navigation bar will move with the resized form and may cover other 
buttons to the left of the navigation bar. The recommended screen size is the default size after resetting 
to default (select 'Reset Form to Default' from the File menu under Help->About). 
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Reports Menu 

Almost all forms contain the Reports option. This selection contains access to the reports linked to the 
form. You can add, edit and delete reports from the dialog box to meet your particular needs. 

The report option supports the ability to choose a printer, to print the report to screen, a printer, a file, 
or email. The report form also provides a place to enter select criteria to limit the report results. 

Printing Reports from EnterpriseIQ 

Several reports are available for viewing or printing from each of the modules within the EnterpriseIQ 
system.  

NOTE: A report listing all reports by menu along with their selection criteria is available from the main 
EIQ Launcher Bar bar under the Reports menu. 

If you wish to print a report from any module, follow the steps below: 

➢ Select REPORTS from the menu bar. 

➢ Select PRINT and the following screen will be displayed. 
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NOTE: The information shown on your screen may differ from the information shown in the illustration 
above depending on what module you are looking at. 

From this screen, you will see a listing of all available reports for the module that you are currently 
working in. To find a report use the scroll bar or enter text in the white field at the top of the form to 
hyper-browse to the desired report. If a specific report is not shown or you wish to add, edit (customize), 
or remove a report, please refer to the section below. 

Print Report Options 

From the Reports menu the following functions are available: 

Selection Criteria 

Use this section if you wish to list only certain records in the report. If you wish to have your report show 
only limited groups of information, enter your sorting process in the selection criteria and destination 
box.  

The information in the From and To fields can be entered manually or be selected from a list. To access 
the list click the ellipsis button in the From and To fields, then select the record from the list. The list will 
be filtered based on the EPlant the user is logged into.  When using the ellipses on vendors and 
customers the filter will display all vendors and customers for the EPlant the user is logged into as well as 
any null EPlant customers and vendors.The Report selection criteria search settings for the pick list are 
remembered per report. (The pick list that appears when selecting the ellipsis button can be edited to 
include additional fields to assist the user in selecting the desired record. See the 'Editing an Existing 
Report' section below for more information). 

Use Like -  For alpha characters, when the ‘Use Like’ is set to ‘Y’ the user is able to enter a value and the 
system will use a '%’ (wild card) with their entry in the From column (the 'To' column becomes inactive), 
and the report will include data that is similar.  The ability for 'Use Like' for numeric selection criteria 
fields is also available. When entering selection criteria, toggle Use Like to Y and enter the numbers you 
wish to search for followed by % in the From field. (ex. 535%). Reports that have Criteria fields display 
the ‘Like’ operator along with the report selection criteria at the top of the report. 
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The selection criteria and destination box search parameters are different for each report listed in the 
report box. Use your arrow down keys to see how the search parameters change. If you wish to add 
additional search parameters, please refer to the section on editing a report in this document. 

PLEASE NOTE: When entering data in the selection criteria in the To and From fields, users may not enter 
quotes (single or double) in the fields, even if the record they are searching on has these characters.  
Certain characters are allowed, for example if a company has a slash or asterisk in their name, that is OK.  
But when querying data, Crystal Reports generator cannot use the single and double quotes. If an 
apostrophe is part of the selected value the user will receive an error stating, "The ) is missing." For 
example, if the Selection Criteria for a company name in the From field is AC’S WIDGETS, this will 
generate the error. If the selection range is expanded so that the selection criteria is from the company 
prior (assuming it does not have an apostrophe) to the name including the apostrophe, the report will 
run without error. As an alternative solution the user can enter the selection criteria in the Customer 
Number field instead of the Company name. 

Save Report Criteria 

Users can save Report Criteria for reports and select them for use later. Enter the report criteria to be 
saved for a report. Post edit the changes before saving the criteria. Select the 'Save Selection Criteria' 
button, enter a description, and select OK. Saved criteria can be accessed by selecting the Search button. 
The pick list is filtered based on the User ID and report name. 
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Choose the selection criteria to use and press Select. It will populate the Selection Criteria tab on the 
Registered Reports form with the information from the selected record. Records can be deleted by 
selecting the 'Delete highlighted selection criteria' button on the pick list.  

Additional Buttons 

▪ Setup - Selecting the function will allow the user to change the printer default settings if necessary. 

▪ Print - This function will print the report directly to your screen to review prior to printing. There may 
be more than one record to view. You have the option of being able to output ALL or only a single 
record to the printer. Some reports may not have this option available if they have been set up with 
the 'Disable Print Button' checked. If this is checked, only the 'Current Record' button can be used to 
print the report, the Print button will be disabled. 

▪ Current Record - This function will print the current record you are viewing directly to your screen to 
view prior to printing. This will only be available if the current record table and column have been set 
up on the report. Note: The current record button in the reports menu will override the filters within 
the report. 

▪ Exit - Exits back out to the main form. 

Destination 

▪ Screen - Select this function to print the report to the screen. From the screen view the report can be 
printed by selecting the Print Report button; or exported to a file or directly to an application for 
several file types (such as: doc, pdf, rpt, xls, csv, rtf, and xml) by selecting the Export Report button 
Upper left corner. (Note: It is not required to have Excel installed to export a report to a file in Excel 
format). Users can click on the group tree to filter the report data, and then export only the filtered 
data. For example, on a report with multiple Mfg Types (such as the Work Center Schedule report) 
users can Toggle Group Tree on with the button, then select a Manufacturing Type from the group 
tree. In the report, double click on the Mfg Type header, then the report will be filtered to only that 
Mfg Type. The report can be returned to the original view by selecting the 'Close Current View' 
option in the upper right corner. 

▪ Printer - Allows you to specify the number of copies to print of that particular report and whether the 
copies should be collated. What you set up here is specific to that report only and will not change 
unless you change it. 

▪ File - Allows you to print the report to a file in the following formats: Microsoft Word, RTF (Rich Text 
Format), Comma Separated Values (CSV), Plain Text Format (ASCII), Adobe Acrobat PDF, Microsoft 
Excel, Microsoft Excel (Data Only), and HTML4. The user must provide the name of the file and 
specify the path of where the file is to be stored. If that information is not entered and the Print 
button is selected a warning will appear: "File Name cannot be blank. Please revise". Users can check 
the 'Open File Upon Saving' check box to have the file opened immediately after the save procedure 
has completed. 

When printing from a speed button users can select the ellipsis button in the File Name field to 
specify the file name formatting or the file name can just be entered in the field. In the Format File 
Name pop up box enter the Separator and then specify the format setting by selecting from the 
available options and arrowing over to the selected side. This format is only used for the File type 
destination. 
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▪ Email - Allows you to email the report to one or many email subscribers. There is some set-up within 
system parameters that needs to be performed before the email destination works. Please see the 
section on the Email Tab in Company File Information for more information. If you use Microsoft 
Outlook as your email system a copy of the email will be placed in your 'Sent' box upon emailing the 
report. This is also enabled in System Parameters, in Company Information, on the Email tab. Check 
the box 'Use Microsoft Outlook'. Any attached documents (internal and external) that have been 
linked via the ‘Print With’ functionality used throughout the system will also be emailed along with 
the report.  

Email Field Listing: 
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To When selecting Email as the destination for reports printed from the reports menu or 
speed buttons, after selecting the Search button the screen will open to the 'Select Mail 
Recipient' form. Select the drop down arrow in the' Select an Address list' and choose from 
from Customer, Partner, Vendor and Employee contacts, or Outlook contacts.  

 

An option to only show contacts with email addresses can be checked to filter out records 
that do not have an email address. If the filter is not selected the records that do not have 
an email address will be grayed out in the multi-select form to choose the recipients from. 
Once the recipients are selected in the list, press the Add button to add them to the 
Message recipients section. Then select OK to email the report. 

In some modules such as Purchase Orders, Pick Tickets and Sales Orders, when printing 
from a speed button, an additional option exists to select contacts from the customer or 
vendor contacts associated with the record. Select the 'Add TO Address' button next to the 
'To' field. Then select the Add from 'Principal' option. A multi-select form will appear to 
choose the recipients from. 
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You may also manually type in any valid email address. 

Note: When the Use Outlook option is checked in System Parameters, but Outlook 
has not yet been setup, when selecting an email recipient from the report 
destination tab, users will receive the message, ‘Cannot complete the operation. 
You are not connected.’ Once Outlook has been setup, the user will not receive 
this message when adding email recipients. 

Note: The Outlook signature (including images) of the sender will automatically 
populate in the body of the email when reports are emailed when using the 
reports menu or from a speed button. 

Subject The subject of the email. 

Bcc Bcc email address of who you would like blind copied.  

Body Optionally enter text for the body of the email. 

Attachment The report can be sent as an attachment using one of the following formats: RTF (Rich Text 
Format), Comma Delimited, ASCII, Adobe Acrobat PDF, Excel, or HTML4. The default is PDF. 
The recipient(s) do not need Crystal Reports to view the report.  

Attachment Name The user can also enter information in the Attachment Name field to override the default 
attachment name which is the report file name.  
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▪ Fax - Allows you to fax the report to one or many fax numbers. Please see the Report and Printer 
Management in EnterpriseIQ https://my.iqms.com/cfs-file.ashx/__key/Technote/Report-and-
Printer-Management-in-EnterpriseIQ.pdf TechNote for additional information. 

Notes: A report cannot be printed if it is open for editing. The user will receive an error stating, "IQRep: 
Error Unable to run a report that is currently being edited!  Load report failed (Repdef Action: Check 
Configure .NET Report)". 

There are some differences when printing a report from a Printer speed button. Please reference the 
Speed Buttons section for more information. 

A cleanup procedure runs when reports are emailed to remove PDF files that are not marked ‘Read Only’ 
from the local home that are more than three days old. When reports are emailed using the PDF file 
type, they are removed from the local home immediately after being attached to the email to prevent 
unauthorized access to sensitive data included in the reports and speed up the running of IQStatus. The 
first time a report is emailed, it may take significant time to clear all of the old PDF files. Subsequent 
emailing of reports will eventually clean out the entire local home folder of old PDF’s not marked ‘Read 
Only.’ 

A watermark will be added to the report if a user selects a destination of printer and then selects the 
IQMS PDF Printer. For reports to not have the watermark select a destination of ‘File’ and choose ‘PDF’ 
from there. (The Nova PDF printer will convert to a PDF without a watermark when called through an 
internal process such as an Auto EForm or Document Control but not when called through a different 
process such as printing a report).  

Troubleshooting 

Report Fails to Logon Error: 

If the report fails to logon and the report contains a stored procedure, the user will get the following 
message if the procedure fails to login: 

Unable to determine Package name for stored procedure {0}. 

Please see help files for 'Crystal Reports - Using Qualifiers/Packages'. 

Solution: 

If the report falls into this scenario, the report designer should add a TextObject to the report.  The text 
of the object should be the name of the package that the procedure resides in.  The user should then 
right click the TextObject and select Format Text…, and then change the object name to 
PACKAGE_PROCEDURENAME where PROCEDURENAME is the name of the procedure being used.  The 
report designer may hide the TextObject so it is not visible on the report. 

Example 

The procedure GETSPLITTIME from the TA_MISC package is being used in the report.  Create a 
TextObject with an object name of PACKAGE_GETSPLITTIME and set its text to TA_MISC 

https://my.iqms.com/cfs-file.ashx/__key/Technote/Report-and-Printer-Management-in-EnterpriseIQ.pdf
https://my.iqms.com/cfs-file.ashx/__key/Technote/Report-and-Printer-Management-in-EnterpriseIQ.pdf
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EnterpriseIQ will now be able to locate the package where the procedure resides. 

Adding a Report 

To add a report to the reports menu, follow the steps below: 

➢ Right click anywhere within the main Report selection screen. 

➢ Select ADD from the menu. Use this function to add a report that you created in Crystal 
Reports to the Report list. Selecting Add will bring up the following screen. 

 

➢ Double click on the report you wish to add to the reports list. The following screen will 
appear: 
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➢ Change the Report Description, define current record, add to the selection criteria, or set 

parameters if the report contains a formula. (See the Edit Report section below for more 
details). 

➢ Click on [OK] to add the report to the list. 

Adding a report from another report menu 

Reports can be added to a report menu using drag and drop functionality. Open the report menu for 
both modules then simply drag the report from the menu it currently is in to the report menu where you 
would like it to also be. All of the selection criteria will follow. 

Removing a Report from the Reports List 

To remove a report from the reports list, follow the steps below: 

➢ Highlight the report you wish to remove, right click and select REMOVE. The following 
prompt will appear: 
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➢ Select 'Remove' to remove the report from the menu until the next software update, where 

it will then be restored back to the menu. Or select 'Hide' which hides the report even after 
an update, these reports can be displayed at a later date. Please see below. This is a global 
setting and all users will not be able to 'see' these reports if they have been removed or 

hidden. 

➢ Reports that have been hidden can be displayed again by right clicking in the reports menu 
and selecting 'Show All Reports', the following screen will appear. 
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➢ Un-check the 'Hide' check box to display those reports you wish to display in the reports 

menu. 

Editing an Existing Report 

Use this function to edit a report you have added to the reports list. Selecting edit will bring up the 
following screen: 

 

Below is a field listing describing each of the fields shown on this screen. 

Report Name This field shows the name of the report selected along with the file extension. This is the 
actual file name of the report created in Crystal Reports. 

Report Description Use the field to enter the name of the report as you wish it to appear in the reports list. 

Report Owner A report owner can be assigned to a report by clicking the ellipsis button in this field and 
selecting a user from the pick list. The IQMS and RTBox users are not included in the pick 
list for selecting the Report Owner. 

Note: For IQMS owned reports users cannot change the report owner. The field is grayed 
out and the ellipsis is inactive. 

Execute Before 
Printing 

By entering the name of a stored procedure here the user can specify the procedure to run 
just prior to printing the report. Select the procedure from the drop down list. To clear a 
selection, press the [CLEAR] button. 

Language A specific language can be assigned to reports using the drop down list. If a report is 
assigned a language, only users with that language or no language assigned to them in 
Security Inspector will be able to see the report in the list. 

Note: The user IQMS will see all reports. 
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Designated Mfg 
Type 

Reports can be associated to a certain manufacturing type.  Therefore users who do not 
use certain types (not listed in Mfg Types) can exclude them from reports menus through 
the Edit Report function. The DELMIAworks report writer will associate some reports to 
certain types, but users may also adjust their reports. 

Selecting the tab entitled DEFINE CURRENT RECORD (while you are still in the Edit Report Definition 
screen), will bring up the following screen. Below the illustration is a field listing describing the fields 
shown. 

 

Current Rec. 
Table.Col Identifier 

This field is the current IQWin32 table and column that will be used in selecting the current 
record. Please contact DELMIAworks for more information on setting up this field. 

Corresponding 
CRW Table.Col 

This field is the Crystal Reports table and column used to select the current record. 

Currently Open 
Tables 

 A pick list of available tables and columns is available (by double clicking on this field), to fill 
it in. 

Database Tables & 
Views 

 A pick list of all Tables and Columns relating to the corresponding CRW Table.Col. Double 
click on any of the views shown to make your selection. 

Disable 'Print' 
button 

If this is checked, only the ‘Current Record’ button can be used to print the report, the ‘Print’ 
button will be disabled. If users want to use selection criteria, they will need to have this box 
unchecked. 
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Selection Criteria 

Selecting the Selection Criteria tab will bring up the following screen. This section is used for adding 
additional report sorting options to the selection criteria portion of the Reports listing screen. 

 

# Shows the sequence number of the option which is to appear in the Selection Criteria 
portion of the screen. 

Param Label This is the name of the field as you would like it to appear on the menu. This is a free form 
field. Simply type in the field label here. 

CRW Table.Column This is the actual table name to query on 

= ? “= “means equal. “NOT” means not equal to. 

From Default from setting. Leave this field blank if you would like the user to enter this value. 

To Default to value. Leave this field blank if you would like the User to enter in this value. 

And/Or Used only with multiple selection criteria to specify if both criteria have to be met or only 
one or the other. 
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PLEASE NOTE: Posting (saving) should be done after each selection criteria entry. 

Adding User Defined Parameter Pick list: 

When selecting the criteria for a report users can select the information from a pick list. Additional 
columns can be added to this pick list by right clicking on the CRW Table.Column on the parameter and 
selecting 'Define Pick list Optional Columns'. Select the insert record button and then the ellipsis button 
to access the column pick list. Select the additional columns from the list. Continue this process until all 
the desired columns have been added. Below is an example where the Company and Attn columns were 
added to the Vendor # selection criteria parameter, with the resulting pick list. 
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Note: Only the main column value will be populated in the selection criteria and passed to the report.  
The ‘distinct’ selection, however, will be on a combination of all the columns so the optional columns 
should be limited to only the columns in the same table as the main column. For example, if the main 
selection criteria is on ‘arinvt.class’ you would not want to add ‘arinvt.itemno’ as an optional column. 

Clone 

The clone option allows users to clone an existing report including the report definition information such 
as selection criteria and formulas. This is useful when modifying existing reports.  

To modify an existing report: 

➢ Go to Reports -> Print and find the report. 

➢ Right click and select Report Editor to open the report in Crystal. 

➢ Modify the report and save it with a new name. 

➢ Close Crystal. 

➢ Right click on the original report again in the reports menu and select Clone. 

➢ Select the newly modified report from the list. 

➢ The Edit Report Definition screen will appear: 
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➢ Make sure to give it a new description and modify the selection criteria if necessary. 

Information 

Selecting this function simply provides the user with information about the report such as the module 
you are printing from, the report path and file name of where this report is stored. In the illustration 
below, the report is located in the main order entry reports menu and is stored in the subdirectory of 
IQWin32 in the reports folder. 

 

Select [OK] to return to the main report selection screen. 

Report Editor 

This right-click option will open the selected report in Crystal design view. Security permissions can be 
granted/revoked with the ‘ReportEditor1’ feature in Security Inspector. 

Reports Security 

Once the report has been added to the Registered Reports screen, you must grant security rights to the 
report. Other users will not be able to access the report until this step is complete. 

➢ From the main launcher bar, click on Sys Setup/Security Inspector. On the left side of 

Security Inspector make sure you are on the Roles tab. 
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➢ Open the module in which you have placed your report. Click on Report/Print. The following 

illustration indicates that, as you open up reports, the Form's Security Items in Security 
Inspector changes to FrmRepDef. Verify you are highlighted on the correct role on the left 
side and then highlight the Crystal report in the Form's Security Items. Click on the visible 

box twice to enter a black check mark. 

 

This report is now available to all users with this role. Rights may be added to as many roles as necessary. 
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Reports Catalog 

The entire Reports Catalog is available from the System Setup tab or from the File (or File->System) 

menu on the launcher bar. On the System Setup tab select the Reports Catalog button  and the 
listing of all the reports will appear. 
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The Catalog Name and App ID are listed on the left. As the user highlights a catalog the reports 
associated to it will appear on the right. The catalog can be sorted based on the Catalog Name or App ID 
by selecting the desired column. Hyperbrowse searching is available by typing in the white area the 
known information. Advanced search is also available using the Filter Dataset button. (See Advanced 

Search in the Pick Lists section for more information). All the same functionality available from report 
menus are available in this form also. 

Note: By default all users will have access to the Report Catalog. This is to allow visibility of all available 
reports. Non-DBA users will only be able to see and run reports they have been granted security rights to 
in the right section of this module. To completely revoke access to the Reports Catalog, disable 
sbtnRepDef_Cat, ReportsCatalog1 and ReportsCatalog2 from IQLauncher. When the security item 
'sbtnRepDef_Cat' is marked disabled and visible the reports catalog icon on the EIQLauncher bar will be 
grayed out. 

All users can right click on Catalog Name/App ID and select 'Show All Reports' to see all the reports 
associated to the catalog regardless of security. The reports the user does not have access to will be 
listed but grayed out. This is informational only. 
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View Report Catalog 

Selecting this right click option from a reports menu or the right section of the Reports Catalog will bring 
up a PDF file describing the highlighted report. The Report Catalog information can only be viewed on 
computers with Adobe Acrobat loaded. The PDF document gives a brief summary of the report, displays 
a sample report, describes the columns, and lists the selection criteria, parameters, and sub reports if 
applicable. 

View Saved Selection Criteria 

Selection Criteria can be saved by users for reports from the Registered Reports form within the 
modules. From the Reports Catalog the saved criteria that all users have added can be viewed by 
selecting the Search button. A pick list of the criteria will display. The list includes the Description of the 
criteria and the User Name that created the saved criteria. 

 

Records can be deleted by selecting the 'Delete highlighted selection criteria' button on the pick list. 
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Reports Execution Log 

The Reports Execution Log displays the reports that have been run during the selected time frame. The 
log displays information such as: number of times executed, last execution date, the user name, and 
execution time. All reports run will appear in the log including reports printed in IQAlert and WebDirect. 

Note: The RFQ, BOM Tree, and Quote Letter are not captured in the log because they are not reports. 

To access the log right click from any reports menu and select Reports Execution Log. The following form 
will appear: 
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The time frame criteria defaults to one month back from the system date. This can be changed by 
selecting different dates using the drop down calendar in the From Date and To date fields. Once the 
desired dates are entered click the Apply Selection Criteria speed button to refresh the data. 

Top Section Fields: 

▪ Report Name - The actual Crystal report name. 

▪ Executed - The number of times the report was executed in the selected time frame. 

▪ Last Executed - The date and time the report was last executed. 

▪ Longest Execution - The length in seconds for the longest execution time. 

Bottom Section Fields: 

▪ Log ID - A sequential numeric value associated to the log record. The first report ran will be 1, the 
second will be 2 and so on. 

▪ User Name - The user name of the person who ran the report. 

▪ Executed On - The date and time the report was executed. 

▪ Execution Time - The length in seconds it took for the report to execute. 

▪ Destination - The destination the report was sent to (Screen, Printer, Email (including the email 
addresses, Fax, or File). 
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Help Menu 

Almost all forms contain a help menu. From this menu the user can choose Contents, Knowledge Center, 
MyIQMS, or About. From the Help menu on the Launcher Bar there are three additional options: Help 
Topics, What's New, and Velocity Metrics. 

Contents 

The Contents menu will link the user to the Help Files for the specific module. The help files have a listing 
of Contents, Indexes, and search tab. The Contents tab lists all of the topics within the specific help file. 
The user can expand the list by clicking on the plus (+) next to the topic to find additional subtopic 
information. 

The Index tab lists all words that are part of the index. Type the word you are looking for in the white 
space at the top and the system will automatically browse to the indexes that match. Once an index is 
found, double click on it to bring up the corresponding section in the help file.  

Ctrl F function - Once a topic is open, additional searching may be done by entering Ctrl F, and then 
typing the word or phrase on the pop up 'Find' box. If found, the help page will jump to word or phrase 
and highlight it as well. Select the Highlight all matches box to have all matching references highlighted. 
Use the Previous and Next buttons to jump to additional references to that word or phrase in the topic. 

The Search tab allows the user to search for a specific word or phrase. Type in a keyword in the white 
space then select the List Topics button. All of the topics with that item in them will be listed. Double 
click on the topic to bring up that portion of the help file. The word searched for will be highlighted in the 
help file selected. If you only want to find the exact phrase then use quotes. For example, if you type 
bom control it will bring up all of the topics where it finds bom and control. If you type “bom control”, 
then it will only look for that whole phrase and will typically return less topics to search through. 

Links to TechNotes - Where applicable, a link to a TechNote may be in the help file to provide additional 
information on a subject. When selecting the link, the user will be asked to log into MyIQMS to access 
the actual TechNote. 

Tip: Use the Knowledge Center option on the Help menu to search through all documentation, this is 
described below. As another option for those using EnterpriseIQ’s Document Control module a 
document library can be created that contains all of the help files in the pdf format as well as the 
TechNotes. Once all of these documents are added to the library, users can utilize the dtSearch 
functionality built into Document Control. This enables searching through all of the DELMIAworks 
documentation at one time. 

Note: Some pop up boxes do not have a Help menu. Often times a link to the correct help section is 
available by selecting the <F1> key. 

Note: Users can check for updates and download the latest *chm version of the help files (those that are 
accessed from the Help menu) by going to MyDELMIA|Works 
https://my.iqms.com/support/helpfiles/default.aspx and selecting your current software version. 

Printing Help Files 

https://my.iqms.com/support/helpfiles/default.aspx
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The user can print sections of the help file. Select the Print button on the top of the help file, a pop up 
will appear: 
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▪ Print the selected topic - This will just print the highlighted topic (no sub topics). 

▪ Print the selected heading and all subtopics - this will print the highlighted topic and any subtopics if 
applicable. 

(The topics are indicated by a book icon or a ? icon in the Contents section). 

Another method is to copy and paste from the screen itself. However, by default, when copying and 
pasting from a *.chm type file the screen shots will not paste, just the text. It is possible to copy/paste 
individual screen shots by selecting copy from the image and then if pasting into Word, select Paste 
Special and choose 'Device Independent Bitmap'. 

Note: Printing from a *.chm type file does not produce great results. It is recommended that users access 
the *.pdf versions of the help files and print specific sections/pages from that format. 

Printing from the PDF 

The best method for printing the help files is from the PDF version.  The PDF version of the help files is 
available in the TECH NOTES folder in the IQMS master home directory. They can also be found on 
MyIQMS website in the Support Section (accessed by selecting Customer Login at the top of the page. 
You must have a user name and password to access this section). The help files are in the 'EnterpriseIQ 
Manuals' section.  

Once a PDF is chosen, select the Pages button  to view the document's pages. Highlight the page(s) 
to be printed using the Shift/Ctrl keyboard buttons, then right click and select 'Print Pages'. 

Knowledge Center 

The Knowledge Center allows users to search all of the EIQ documentation in the master home 
IQMS\TECH NOTES folder for a specific word or phrase. The first time this is used or if additional 
documents are added to this folder the user will need to rebuild the index. The first time it is used a pop 
up message will appear stating, 'You must upgrade your Knowledge Center Index. Would you like to do it 
now?' Select Yes to build the index. The index can also be rebuilt by selecting the Rebuild Index button 
on the Knowledge Center form. A progress bar will appear: 
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Once the index is built users can enter text in the white field and press the Search button. The results will 
be displayed below showing the number of hits and the document name. Click on the document to 
access it. 

Note: There is an action called 'Reindex Knowledge Center' in IQAlert that will re-index the Knowledge 
Center index files that reside in the master home KCIndex folder, allowing users to perform this option 
automatically during slow times. From IQAlert create an IQAlert Action with the Reindex Knowledge 
Center Type selected. See the IQAlert documentation for more information. 
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The system will display the document after it is converted to html.  The user will be taken to the first hit 
and the matching text will be highlighted in yellow. To view additional hits use the 'Next hit' and 
'Previous Hit' (green arrow) buttons. 
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MyIQMS 

The option accesses the MyIQMS website which provides information and support for EnterpriseIQ 
software. It is an all inclusive location to find a lot of useful information on EnterpriseIQ. The following 
areas are available to users: 

▪ Support – The support section includes access to news information, known issues, EnterpriseIQ 
manuals, product updates, TechNotes, and access to Support Issues. 

▪ Report Requests - You can submit a request for a report. 

▪ Discussion – This section is an DELMIAworks message board, this is the place to post questions to the 
DELMIAworks customer base for solutions. Users can share files and reports while learning about 
other users’ best practices. This is a useful resource destination for users to interact with other 
EnterpriseIQ users. 

▪ Blog – This portion provides access to the DELMIAworks Blogs. 

For detailed information on MyIQMS please refer to the MyIQMS TechNote https://my.iqms.com/cfs-
file.ashx/__key/Technote/MyIQMS.pdf. 

About 

The About menu has two sections that display the General Info and Release Info. The General Info 
includes the following information: Company Name, Enterprise EPlant, User Name, Oracle Alias, Server 
Name, Instance Name, Oracle DB Version, Oracle Client Version, and Database Type. The Release Info 
has information on: Release, Release Level, Cryptography, Module Name, Module Version, and 
Executable Date. The module name and version number listed are associated with the current open 
form. Occasionally you may be asked this information when calling in to the Support department. 

https://my.iqms.com/cfs-file.ashx/__key/Technote/MyIQMS.pdf
https://my.iqms.com/cfs-file.ashx/__key/Technote/MyIQMS.pdf
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Other options from the about form include: 

▪ Website access - Select the 'DELMIAworks' text to be taken directly to the DELMIAworks website. 

▪ Email Support - Select the 'Email Support' text to create an email to the support department. The 
email will automatically contain General information such as Company Name, User Name and Oracle 
details as well as Release Information such as Release Level, Module Name, and Cryptography. 
Simply type your question for a quick response. 

▪ Web Support - Select the 'Web Support' text to be taken directly to the  DELMIAworks Support web 
page where you can access Documentation, Knowledge Base, Downloads, Communities, and more. 

If the 'Display Last Login' setting is checked in Security Inspector -> Password Policy, the following 
information will also display on the About form: 

▪ Last Login - Displays the last date and time the user logged in. 

▪ Last Failed Login and Failed Login Tries - Displays the last date and time there was a user failed login 
and the number of failed login tries. The Failed Login Tries will reset after a user logs into the system 
successfully two consecutive times. 

Note: The About screen of modules that launch a credit card executable will include the PCI Version. The 
PCI version includes a set of three numbers separated by a period. The first set of numbers is two digits 
and indicates the Security Version. The second set of numbers is two digits and indicates the Module. 
This is used to track low to high-impact changes to the credit card module. The last segment represents 
minor changes (such as bugs or cosmetic changes) that do not fall into the first two sections of the 
version. 

Menu Options 

File Menu: 

▪ Reset Form to Default - This resets the form to the default status. It does not reset check box options. 
This feature correct errors that may occur when resizing columns in a form. 

▪ Bring Main Window Front - This will bring the main window to the front and close the About screen. 

Options Menu: 

▪ Alter Session - This feature is accessed from the Options menu and is used for a trouble shooting and 
tuning performance tool. It returns SQL tuning information such as usage statistics, shared pool, rows 
processed, etc. If you are experiencing speed issues a technical support person may request you set 
this feature for the module you are experiencing problems with. 

Time Zone Offset - The time zone offset should not need to be manually adjusted as the time zones will 
adjust according to the user's desktop Windows time zone format.  In old versions of EIQ this option 
was used to adjust the time zone offset for RealTime™ for the number of hour’s difference between the 
local site where the computer lives and the main plant where the Oracle server lives.  

Additional Options from the Launcher Bar Help Menu 

There are three additional options from the Launcher Bar: Help Topics, What's New, and Velocity 
Metrics. 
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Help Topics 

This opens the Help file to the cover page. Selecting 'Contents' will open the help file to the topic 
relevant to the form it was selected from, i.e 'Launcher Bar Functions' topic. 

What's New 

This opens the 'What's New in DELMIAworks' help file. 

Velocity Metrics 

Velocity Metrics within EnterpriseIQ is a diagnostic tool which measures the speed of common actions 
and displays the results in a form.  This is designed to assist engineers in trouble shooting speed issues. 
Velocity Metrics can be accessed from the Help menu of the EIQ Launcher Bar.  

Note: The menu item is only visible to DBA users. 

When it is first accessed the application will be disabled.  
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 There are three ways to enable tracking: 

▪ Double click the message bar and select Yes to confirm 

▪ Click the Enable Tracking button   

▪ Select ‘Enable Tracking’ from the Options menu 

There are two options for tracking velocity, Enable Tracking and Enable Verbose Tracking. Tracking will 
occur as long as the Enable Tracking option is checked. (Verbose Tracking does not have to be checked). 
It is unnecessary to check Verbose Tracking unless asked to do so by your Support representative. 

▪ Enable Tracking – This is the standard tracking option. It will include results for the elapsed time to 
load forms and pick lists, and the number of Hits. When only this option is checked, if the same form 
is accessed more than once, the matching record is overwritten with the latest results. Additional 
rows are not created for the same tracking item. 

▪ Enable Verbose Tracking – This option can be checked in addition to the Enable Tracking option to 
provide more tracking details, which includes the activated datasets and the start and stop times for 
each row. This option enables users to know which dataset may be the one causing slowness issues. 
Verbose tracking adds a separate entry for each tracking item and does not count the number of 
“hits” for each entry. 

Note: It is recommended to clear any data in the grid prior to switching from one option to the other for 
the results to be logical. 

The application will still track velocity when closed if it is enabled. Once opened select the refresh button 
to load all the data in the grid. 

Viewing the Velocity Metrics 

Once enabled, as a user accesses areas of the software an entry is tracked. By default, it will insert 
records when a form is opened, and pick lists are accessed and sorted.  

Grid Fields – With Enable Tracking only checked: 

Description 

 

The Description includes the location accessed and the action taken by the users. It 
also includes the component name for the pick list that was accessed. 

Elapsed 
(seconds) 

 

The number of seconds to perform the action. 

Hits 

 

The number of Hits is the number of records accessed from the pick list. When the 
same pick list is accessed the existing row is updated with the latest elapsed time and 
hits. A new line is not created. 

Grid Fields – With Enable Tracking and Verbose Tracking both checked: 

Description 

 

The Description includes the location accessed and the action taken by the users. It 
also includes the component name for the pick list that was accessed. 

This view also includes rows with information on the Activated Dataset such as 
"QryArCusto" and "TblPartNo". ßWhat is this called in developer terms? 
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Elapsed 
(seconds) 

 

The number of seconds to perform the action. 

Start  

Stop 

 

The Start and Stop Date and Time relevant to the specific action. This information is 
displayed in format: MM/DD/YYYY H:M:S AM or PM 

Below is an example of accessing the BOM pick list and selecting one record with just Enable Tracking 
checked: 
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Below is an example of accessing the BOM pick list and selecting one record with Verbose Tracking 
checked: 

 

Save 

 Click the Save button to save the list of records to a *.csv or a *.txt file. A 'Save A's form will display 
for users to choose a location, enter the File Name, and select the file type. 

Clear 

  Select the Clear Button, or choose Clear from the View menu to clear all the data from the form.  
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Documents 

Many modules throughout EnterpriseIQ contain a Documents tab. From this tab users can add Internal 
and/or External document, as well as Email Correspondences that pertain to the specific record (i.e. 

Customer, Inventory Item, BOM). When document(s) are present on the tab an icon  will display 
indicating this. The system will remember the selected tab (Internal, External, or Email Correspondence) 
that was last chosen in the registry. 

Often times the documents can be set to automatically print with another form such as packing slip, 
work order, etc. 

Note: Attached documents will only print when the selected destination is Printer or Email. They will not 
print when the selected destination is Screen or Fax. 

Internal 

Internal documents are created using the  internal Editor. It functions like a word processor. URL links 
are supported in Internal Documents. Users can click on the link within the document to be taken to the 
resource. Graphic images may also be imported into the document or text area. EnterpriseIQ supports 
.BMP graphic files only. To insert a graphic, select File->Open and select the desired graphic. Note the 
document can only contain a graphic or text, but not both. 

Note: The graphic will not print correctly when added as a document with a print with option selected. 
Use External documents in order to print a graphic using the print with functionality. 

The following is a sample of the Internal documents screen in the customer module. The user can add, 
edit, delete, or print documents from here. 
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To create a new internal document select the add (+) button and the following form will appear. 

 

Select the Create New Document option, enter a Description, and select OK. The Editor form will appear. 
Enter the text in the space. 

 



Using EnterpriseIQ - Basic Functions Page 67 of 134 

 

To associate an existing internal document to the record select the Add button and then select the 'Pick 

Existing Document' option. A pick list of existing internal documents will appear. Select the document 
from the list. 

To delete a document select the (-) button. A confirmation box will appear. Select the box to remove the 
document from the System, or leave it un-checked if the document should remain in the system. Select 
Yes to confirm the deletion. 

Select the up arrow button to Edit an existing internal document. Choose Edit Document Contents to 
open the editor to change the actual document. Or choose Change Description / Sequence to just change 
the name or sequence number. Note: Selecting the 'F5' keyboard button will add the current date and 
time to the document's text. This also applies to the various note fields throughout the system that use 
the Internal Notes Editor (i.e. the SO Item Information field in Inventory). 

An internal document can be printed by selecting the printer icon. 

IQSpellChecker 

From within the IQEditor the user can select Check Spelling from the Tools menu. This will check the 
contents of the document for spelling errors using IQSpellChecker. 

Note: Spell checker is also available as a right click option in pop up forms such as 'SO Item Information' 
in the Inventory module. 

Select the 'Check Spelling' option and a form will appear displaying any misspelled words with options 
for corrections, additions, and changes. 
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Note: Internal Documents can be embedded in a Crystal report by using the following command in a SQL 
Expression inside of a Crystal report: UTL_RAW.CAST_TO_VARCHAR2(DOC_BLOB) 

External 

This section enables the user to be able to insert or open documents created in different applications 
such as Microsoft Excel spreadsheets, Microsoft Word Documents, Acrobat Reader, Word pad, Bitmap 
images, video, sound clips, etc. and map the path to these documents so that anyone can access them. 
To open or print an external document the work station must support the software the document was 
created with. 

No Document Control: To Add a new document in this section for users without the Document Control 
module there are two options - Drag and Drop or Browse: 

➢ Drag and drop the document from Windows Explorer into the External document tab. This 
option allows users to add external documents from Windows Explorer without having to go 

through the steps of browsing for the file. 

To Add a document using the browse method: 

➢ Click on the [+] function key located on the Navigator bar. 

➢ Use the Open dialog box to locate the document you want to link with this customer. Accept 
your choice by clicking Open. 

➢ Be sure to click the Post icon to save your new entry. 

With Document Control: To Add a new document in this section for users with the Document Control 
module, documents can be added from a library or by dragging and dropping it from Windows Explorer. 

Adding a document from a library: 

➢ First select the Library by selecting the [+] function key or by clicking in the Library field and 

selecting the ellipsis button. Select the library where the external document resides and 
press OK. The list of libraries is filtered to show the those that are associated to the EPlant 

that the user is logged into and libraries that have no EPlant assigned. If a library is marked 
Confidential only the library team members will have access to the confidential library in the 
pick list. If the confidential library is selected a warning will appear stating, 'This is a 
Confidential library. Assigning document from a confidential library will make it viewable for 

non Library Team members. Continue?' Select Yes to continue to add the document, or No 
to not add the document. This warning has a 'Do not show next time' option. 

➢ Then from the ‘Select Document from  'xxx' Library’ pick list that appears, select the specific 

document(s) in that library to be attached. This list includes the document description, Doc 
#, file name, status, created and modified dates, and user fields. Use the toggle buttons or 

the Shift/Ctrl keyboard buttons to multi-select several documents to associate with the 

record. Select the Hide Expired toggle button  to only see non-expired documents in the 
list. 
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When a non restricted library is selected users can select the ‘Scan & Append document to library’ speed 

button  to scan and add a new document to the library and the form. The scan document module 
will open, verify the file name and enter the desired color information using the drop down list in the 
'Scan As' field. Indicate whether it is a single scan or multiple pages. When 'Multiple Pages' is selected it 
is important to specify the correct number of pages that are going to be scanned.  

A document can also be scanned to a library by selecting the Scan button on the External Documents 
tab. The Scan Document form will appear. Select the Library from the drop down list and enter the 
additional details such as file name, color and source. 
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Append and Select - If the selected library is a 'No Restriction' library type (including repository-no 

restriction libraries) the user can click on the Append button  to add a document to the library at 
the same time as associating it to the form.   A confirm message will appear stating, "This option allows 
to append a new document to the "Library Name"  library and select the document in one step. Are you 
sure you want to continue?". Select Yes and the 'Assign File' form will appear to select the document to 
be added. Select the Find File button next to the Source File Name field and choose the document to be 
added. (For more information on adding a document to a library, see the Document Control help files). 

Add a document using the Drag and Drop Method: 

➢ Drag and drop the document from Windows Explorer into the External document tab. If the 

file being ‘drag and dropped’ is not part of a library already, the system will pop up the list of 
libraries to choose from, this includes repository libraries. The document will be added to the 
external tab for the record and the selected document library. 

View a Document 
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To OPEN the document: 

➢ Double-click on the file name, or select the document and right click. Select Execute from the 

submenu.  
 

The program will open both the application the document was created in as well as the 
document itself. 

➢ When finished viewing the document, click on Exit. 

Field Listing (alphabetical): 

Note: Sorting is available on the columns on the External tab. 

Auto-EForm On the External Documents tab there is an additional option called ‘Include in Auto 
EForm’ for Auto EForm documents for sources: Invoice, Packing Slip, CoC, BOL, and 
Order Acknowledgment. If this option is set to Y, when the Auto EForm action is 
executed, the system will also send the external documents associated to the Print 
With document. Below lists the reports and areas that have this option: 

▪ Order Acknowledgement - Inventory and Customer Maintenance External Documents 
tab 

▪ Packing Slip - Inventory and Customer Maintenance External Documents tab 

▪ Certificate of Conformance -  Check the 'Certificate of Conformance Required' 
option for the customer (either on the Miscellaneous tab or on the specific Ship To 
record on Forms/Reports), attach an external document to Inventory or the Customer 
Maintenance External Documents tab and select print with Packing Slip.  

▪ Invoice - on the Inventory Item External Documents tab 

▪ BOL -  Print BOL Packing Slips (From the BOL module) for contacts with the 'Auto 
EForm BOL' option checked. 

For Example - To send an External Document for a specific Inventory item with a 
Packing Slip: 

▪ Add the document as an External Document for the inventory item with a Print With 
set to 'Packing Slip'. 

▪ Set the Auto-EForm on that document to 'Y'. 

For contact(s) that have the 'Auto EForm PS' option checked, when a packing slip is 
printed for that item, they will receive the Packing Slip and the external document as 
attachments in an email. 

CUser7 This is the User Defined text field 7 from document control. Only this user field will 
display by default. 

Note: The other six user fields can also display if the 'Show First Six User Fields in 
Module External Documents' option is checked in Document Control Preferences. 

Doc # The document number. This is assigned by the system as the next sequence number. 
It can be changed by right clicking in Document Control and selecting 'Edit Doc #'. 

Document 
Description 

The document description. 



Using EnterpriseIQ - Basic Functions Page 73 of 134 

 

Expired If the document is expired, this column will display a 'Y', otherwise it will display 'N'. If 
it is expired it will be color coded 'olive green'. 

File Name The document's file name. 

Note: If the 'Do Not Show Document UNC Path in Module Ext Docs' Document Control 
Preference is checked, the File Name field on the External Documents tab in all 
modules will be hidden so users cannot see the UNC Path of documents. The UNC 
path is also not visible in the Select Document Library pick list when adding an 
external document to a module. 

Last Modified This is the last modified date for the document. 

Library The library the document resides in. 

No Training Req This field is applicable to External Documents associated to BOMs. If this column is 
marked ‘Y’, the document will be ignored during employee certification. This field is 
visible in other modules but in informational only. 

Place Shortcut For users licensed for Shop Data there are two additional fields: 'Place Shortcut' and 
'Shortcut Sequence'. External documents attached to BOMs with 'ShopData specified 
under the 'Place Shortcut' drop down appear on the RealTime Work Center screen in 
ShopData. The 'Shortcut Sequence' Column allows users to specify the sequence that 
the documents appear.  

Print With Internal or External documents created can be set to print with another document 
such as work orders and packing slips. This option defaults to None when a document 
is added. To assign the print with option, select the option from the drop down list in 
the 'Print With' field. Multiple documents may be selected by holding down the 
ctrl_key + mouse click. Once selected, a dot is placed next to the document on the far 
left as a visual indicator. When multiple documents are selected this allows a user to 
assign the ‘print with’ function in mass via the right click 'Assign Print With' option. 
When selected the document will automatically print when the associated report is 
printed from the Print Speed Button. Attached documents will only print when the 
selected destination is Printer or Email. They will not print when the selected 
destination is Screen or Fax. If the document is in a document library with the 'Convert 
to PDF for Module Display' option checked the PDF version of the document will print 
and will include the watermark. If you do not want the document to print with any 
‘Print With’ option be sure to select ‘None’ from the drop down list if it is not already 
set that way. If left blank the system assumes ‘All’.  To override the print with setting 
and not have the 'Print With' documents print select the 'Exclude attached 
documents' check box on the Print dialog form. This is set per module and affects all 
users, not just the user logged in. This setting is remembered in the registry. 

Note: *.rpt files are not supported for use with the Print With feature. 

Recertification This is the number of months required for recertification. This will carry over to the 
Certified Employees tab in BOMs. This is used in the Labor Scheduling module. An 
employee will display in blue in Labor Scheduling if they are due for re-certification. 
(Due for re-certification is determined if an employees Certified Date + # Months < 
Today's date).  

Revision The document's revision. 
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Status The status of the document such as 'Released'. Each document will display in a color 
to indicate it's status as well. 

▪ Yellow - The document is checked out or new. 

▪ Blue - The document is pending authorization and/or review. 

▪ Green - The document is released. 

▪ Olive Green - The document has expired. There is also an 'Expired' column. If the 
document is expired, this column will display a 'Y', otherwise it will display 'N'. An 
expired document cannot be opened from a module, a message will display stating, 
'The document is not available - it is expired and requires review'. 

▪ Red - File does not exist. 

▪ Gray - The document is inactive. 

Speed Button Options: 

▪ Search - The External Documents tab in all modules includes the Search button  to access the 
pick list for easier navigation through multiple documents. 

▪ Filter Dataset - Each External Documents tab within the modules will have a Filter Dataset button to 
enable users to filter the attached external documents by a field within the library, including the user 
defined fields. Select the filter speed button and enter the filter criteria in the pop up form. For 
example, a user defined field in document control can be used to specify the document type, then 
within a module users can filter the external documents to only show a certain document type. 
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▪ Launch Document Control - This will open the document control module to the library and document 
for the highlighted record. 

▪ Print - This option will open and print the document. 

Right Click Options: 

▪ Execute - This opens the document 

▪ Print - This will print the document.  

▪ Show Revisions - Select this option from the right click menu to view all the revisions of a document. 
Double clicking (or right click and select Execute) on the revision will allow the user to view the 
highlighted revision. 
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▪ Filter Dataset - This is the same option available from the speed button, described above. 

▪ Assign 'Print With' - This allows the user to set a print with for a document. This is the same function 
described in the table above. 

Notes on External Documents: 

When printing attached external documents, the operating system’s default printer is used. This applies 
for all modules where external documents are attached. External documents are not EnterpriseIQ 
documents so the operating system controls where they will be printed. 

When attaching an Excel spreadsheet with multiple tabs be sure to open the master document in Excel 
and right click on the tab for first sheet (at bottom of page..."Sheet1”). Choose “Select All Sheets” from 
the pop up menu. This will group the sheets (as a command) but still keep them separate in the 
workbook. Because they are grouped all sheets will print. 

To better ensure that multiple attached files print, EIQ directly instructs Microsoft Word and Excel to 
print the following file formats:  doc, rtf, txt and xls.  In all other cases we default to the operating 
system for printing. For example, a .txt file will print to Notepad if that is what is set as the OS default. 

With some PDF readers, when printing a .pdf (from anywhere on the workstation, not just through 
EnterpriseIQ), the reader stays open in the task bar and remembers the printer used initially for any .pdf 
print jobs that follow.  The user must close this program before attempting to print a .pdf to another 
printer; otherwise the printer initially used is still considered the ‘default’ for printing .pdf documents. 

In Security Inspector users may grant/revoke access to adding and deleting external documents while 
still allowing navigation through external documents. The insert and delete check boxes are only 
effective if the read/write access is also checked because otherwise the dataset behind the grid is in read 
only mode. For Internal Documents, the security item IQDocs1 is used – by unchecking the security 
attributes for insert, delete and edit, the user is only able to view existing internal documents. For 
External Documents, the security item IQExtDoc1 is used – by unchecking the security attributes for 
read/write, insert and delete, the user is only able to view existing external documents.  

When deleting records in modules having External Doc capabilities (such as MRO, Purchase Orders, Sales 
Orders, etc), any attached External Document records are also deleted from the doc_used table.  

Email Correspondence 

The Email Correspondence tab is available in most modules, such as Vendor Maintenance, Customer 
Maintenance, Sales Orders, and Purchase Orders. From this tab the user can attach Email 
correspondence related to the specific record. 

To add an Email simply drag and drop it from Outlook or other email programs into the form. 

Note: Dragging and dropping from a local workstation to an RDS desktop does not work. Users in this 
environment can drag and drop an email .msg file from a network folder within RDS. 
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If the email is dated today or yesterday, the Received Date will fill in based on the email’s received date 
and time. A Received Date box surfaces if the system is unable to determine the date (such as: the 
Received and Sent dates differ, unclear binary data, or older data, etc.). Users are asked to provide the 
Received Date by selecting the correct date from the calendar. 

The From and Subject fields will also automatically populate with the information from the email. The 
date, from, and subject fields cannot be edited. 

Comment - A comment can be entered by double clicking the field. Enter the comment in the pop up box 
to further describe the email correspondence.  

Filter - A Filter dataset button is available to filter the emails based on one of the fields. Note: If a filter 
has been set and a user adds an email that does not meet the filter criteria, they will receive a notice 
‘Unable to find appended email with the subject line ‘XXX’ – check your filter settings’.  The email is 
added, but it will not display until the filter is deactivated (select the Remove Filter button). 

Notes regarding email correspondence: 

If the email has attachments, or multiple attachments, the total attachment size cannot be more than 
4GB. The size allowance might further be limited by the chosen email program used. In order to view 
emails that have attachments, special formatting (e.g. stationary), or images embedded in the body of 
the email, the user must go into BDE Administrator and set the BLOB SIZE to 1000 for the database they 
are using (i.e. IQORA). 

Security can be placed on the navigation bar on the Email Correspondence tab to prevent users from 
deleting emails. To do this, go to the module where you would like to add security for email 
correspondence and then from Security Inspector, right click and select Add Item. Add the 
IQEmailCorrespondence security item and select the desired security attributes. See Security Items for 
more details. 

When a user runs any EIQ application through Citrix that allows the user to drag and drop email 
correspondence to the documents tab, they must be running Outlook on the Citrix server. You cannot 
run Outlook locally and run EIQ through Citrix and drag/drop email. 

When deleting entities in modules having Email Correspondence capabilities (such as MRO, Purchase 
Orders, Sales Orders, etc), any attached Email Correspondence records are also deleted from the 
email_correspondence table.  
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User Defined Forms 

User defined forms allow the user to create a unique form to store information beyond the scope of the 
original form. Once established, this form is available to all records within the module. Security can be 
set on each user defined form. 

To Create the form: 

➢ Select the User Defined Form speed button , go to the tab, or click the Options menu, 
then User Defined Form. 

➢ If you receive the warning ‘Table does not exist’ click OK to continue.The blank user defined 

form will be displayed. 

➢ Click on the define structure button . The define structure dialog box will appear. 
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Click the + button on the navigator to create each field.   

Column Name in 
the View 

This is the Column name used by the system for the user defined reports. It is the 
name shown in the views. The system identifiers of User# should not be changed. 

If they are changed, users cannot enter a name something that is Oracle related 
such as: Date, Numeric, Char, Data, Query, or Select. Users can enter values such 
as: InventoryDate or Inventory_Date, BoxNumber or Box_Number. 

Field Type 

 

The structure of the field. Choose from the drop down options: 

▪ C - Character field 

▪ N - Numeric field 

▪ D - Date field 

Field Kind Select Data, Query, Linked or Pick List from the drop down list. This field will 
default to Data if left null.  

▪ Data - This is the default and will display the entered data. 

▪ Query - If Query is selected a SQL Statement must be entered in the pop up form 
accessed by clicking on the ellipsis button in the SQL Statement field. 

▪ Linked - If this is selected a database (parent) field is linked to the user defined 
field from the pick list. The system will populate the value from the user defined 
field over to the field in the parent table. It does not work the other way, if you 
change the parent field it does not change the field on the user defined form. See 
below for more information. 

▪ Pick List - When this field kind is selected a DBA user must create an associated 
Pick List SQL to indicate the fields to display in the pick list along with a 'Result 
Field' to display in the User Defined Form field based on pick list record selection. 
The Use Component will automatically be assigned Drop-Down because this is 
the actual component the software is using. 

Label Enter the name of the field that will be displayed on the form. 

Use Component For Character field types only, the user can select a Use Component feature: 

▪ DBEDIT - Select this to have the field be entered manually by the user.  

▪ DROP-DOWN - This option will allow the user to select the data from a drop 
down list, or type it in the field manually. If DROP-DOWN is selected enter the 
Drop Down Text in the bottom section. 

▪ CHECKBOX - This will make the field a check box. 

▪ DROP-DOWN-LIST - This option will require the user to select the data from the 
drop down list only. The Drop Down Text is entered in the bottom section. 

▪ MEMO - This component type will allow users to select an ellipsis button in the 
user defined field and enter up to 250 characters in a pop up form. 
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Parent Column 
Name 

This feature is used to define relational user fields. Users can specify a Parent 
Column for a field on the form that uses the DROP-DOWN or DROP-DOWN-LIST 
components (both the parent and the child must be a one of these). Only columns 
from the current form can be selected. Then in the Drop Down Text section users 
define the relationships that will dictate which child options can be selected if a 
specific parent option is chosen. See below for more information. 

If a user selects values for USER1, and USER2, then changes USER1, USER2 should 
be cleared prior to posting of the form (this should cascade down to multiple 
children of children...) 

SQL Statement This is used to enter a SQL Statement for a query kind user field. Select the ellipsis 
button to enter the SQL Statement in the pop up box. 

Users can create queries that will use user fields to calculate the value for another 
user field.  

Example Query: 

select nvl(user2,0) + nvl(user4, 0) 

  from v_ud_standard_injection 

where parent_id = :id 

This will add the value in the user2 field to the value in the user4 field. Which in 
the example below displays in the User6 field.  

In the screen shot below another query was created that multiplies the two fields 
together with the results displaying in User9. 
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Linked Field Kind 

If the Field Kind is set to Linked select a 'Linked Field Name' from the pick list accessed by clicking the 
ellipsis button in the field.  

 

When a value is entered in the user defined field in the form, it will populate the linked field name in the 
database. It does not work the other way, if the parent field is changed it does not change the field on 
the user defined form 

Pick List Field Kind 

When the Pick List field kind is selected a DBA user must create a Pick List SQL. Select PICKLIST from the 
drop down list in the Field Kind field. The Use Component will automatically populate with Drop-Down. 
To enter the Pick List SQL select the Edit SQL Statement button in the Additional Info section. Enter the 
SQL in the form then select The Result Field from the drop down list.  
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When a user accesses the user defined field on the form they will click the ellipsis button in the field to 
access the pick list. The user field will be populated with the result field based on the selected record. 

Relational User Fields 

To create a relationship between two drop down list or drop down user fields select the ellipsis button in 
the Parent Column Name field for the user field that will be dependent on the selection made in the 
parent's field. For example, the U11DD field has the U4DDL selected as the parent column. 

In the Drop Down Text section for the User9 field the parent drop down option is specified for each drop 
down text choice available for User8. Highlight the text then select the parent drop down value from the 
pick list accessed by clicking the ellipsis button in the field. In the example below if Mineral is selected in 
the parent field (User8), then the user will be able to choose either B or C to populate the child field 
(User9). 
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Layout Manager 

The Layout Manager enables users create a Layout for the user defined columns. Multiple Tabs can be 
created, Groups are then associated to the Tabs, then the fields are associated to the Groups. Select the 

Layout Manager button  to access the layout form. When this is first opened there will be one tab 
with a caption of General, one Group with a caption of Groupbox1, and all of the existing user defined 
columns listed in the Fields section will by default be assigned to the GroupBox1. 
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Tabs 

To add Tabs select the + button in the Tabs section and enter the name of the tab in the Caption field. A 
name cannot start with a number. If the user enters a number an error stating, 'Component name must 
start with a letter or underscore' will appear. 

Groups 

To add a Group to a tab, highlight the Tab name and select the + button in the Groups section, and enter 
the name of the Group in the Caption field. A Group must be added as the fields are associated to the 
groups which are associated to the tabs. The Group name also cannot start with a number. 

Fields 

The fields that have been created will be listed in the Fields section. The sequence of the fields can be 
changed by dragging and dropping the fields into the desired order. 

Associate Fields to Groups 

By default all of the fields will be linked to the default GroupBox1. If additional Groups have been 
created the fields can be added to other groups. Highlight the group to add fields to and select the + 
button in the Fields section or the Append button in the GroupBox on the right. The button will only be 
available for the group that is highlighted on the left. 
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A pick list will appear showing the available fields to add to the group. For a newly created group all of 
the fields will be listed. Highlight the fields to be added to the group using the toggle buttons or the Shift 
and Ctrl keyboard buttons and select OK. The fields added to the new group will automatically be 
removed from the original group they were assigned to. Once fields have been associated to groups, the 
next time the append button is selected only the fields that are not already assigned to the group will be 
in the pick list. 

The number of fields associated to a group will be listed in the GroupBox on the right. Below is an 
example of the Layout Manager form with multiple tabs and groups created: 
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Options 

Next, click on the Options tab. The Options Tab allows the user to change the ‘User Defined Form’ menu 
item name and the form heading. The Menu item name will appear in the drop down menu as well as 
the speed button hint. If the form also has a tab for the User Defined form the Menu Caption will display 
on the tab as well. The Form Caption will display at the top of the form when it is opened. (Note: After 
modifying the Menu Caption in user-defined forms, the forms must be re-opened to display the change 
in the speed button hint). 
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➢ Click on the Create View button. The system will now display the user defined form. The 

example below is based on the layout shown above. 

 

Note: If the form is large scroll bars will be available for users to access all of the form. The User Defined 
form refresh button will recalculate and rebuild (if needed) the vertical and horizontal scroll bars. 
Because the form is highly user driven manual adjustments and resizing are required to ensure every 
component can be reached using scroll bars. 

If a Query kind field has an error the field name will display Error in red. The user can mouse over the 
field to see the hint for the error description. 
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To view an existing User Defined form, select the customized menu name entered during the set up 
process from the Options menu or select the User Defined Form speed button. The system will 
automatically display the customized form. 

Notes:  

When a User Defined Form is created in a module the system creates a new View which can be used to 
add the fields to reports. For example, when a user defined form for Customer Maintenance is created a 
View called V_UD_ARCUSTO is created with a column for the Parent ID, the Tab, and columns for each 
user field added. The User Defined Form data is saved in a single record per PARENT_ID regardless of 
whether there are multiple Tabs and Groups to ensure custom reports and custom labels that use these 
custom views function properly. 

When adding User Defined forms (views) throughout the software, if the user attempts to add a column 
(field) that violates any of the following Oracle rules, they will receive a warning informing them of their 
error: no spaces are allowed, first character of the name of the column must be a letter, only letters, 
digits and underscore are allowed for the rest of name and the length must be equal to or less than 30. 

The field 'Column Name in the View' cannot be named something that is Oracle related such as: Date, 
Numeric, Char, Data, Query, or Select. Users can enter values such as: InventoryDate or Inventory_Date, 
BoxNumber or Box_Number. Note the column names are the field names that show up in the Views and 
are not the ones users will see. Users will see the value entered in the Label field and there is no 
restrictions for what can be entered in them. 

Security will have to be updated for each new field in order for users to access the fields. 

Users can modify user defined form fields on inactive (PK_Hide) records, however user defined form 
fields on archived records are non-editable. 
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User Fields 

Many modules have the User Fields option. By selecting Options|User Fields from the menu the user is 
able to define an unlimited number of user definable fields. These fields are used for informational or 
reporting purposes only. Typically there are both User Text Fields and User Numeric fields. The text fields 
can be populated with alpha and numeric characters. The numeric fields only allow numeric values. The 
length of numeric fields is determined by the precision and scale and unless specifically noted this is 
generally 15 and 6.  The system takes the scale from the precision to determine how many places 
before the decimal that is allowed (for 15 and 6 this is 9, 15-6=9).  The greatest number that can be 
entered is 999999999.999999. 
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To define label text, follow the steps below. 

➢ Right click on a field within the user defined screen and select Define Label Text. The following 

screen will appear: 
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➢ Type in the new caption under New Value and click on [OK]. You will be returned to the User 

Defined screen where you will see the new caption. Click on [OK] to exit. 

Note:  If the Security Inspector setting 'Cannot change User Defined Captions' is checked for a user they 
will not be able to modify User Defined Caption text in any module in the software. 

➢ List User Fields - Some user fields will have a blue drop down arrow associated to them. If 

this option is present the user can define a list that can be used to populate the user field 
rather than manual data entry. To edit the list for a user field, right click on the blue arrow 
and select ‘Edit User Defined List’. A list form will appear to enter the Text selections that 

will be available when selecting the blue drop down arrow in the field. There is a System 
Parameter setting (Company File Information->Application tab) called 'User Defined 
Dropdown Text Only'. With this option checked the system will only allow text defined in the 

drop down list to be entered on user defined drop down fields. This prevents users from 
typing data in a 'drop-down' type user field. This can be overridden on each specific 'Edit 
User Defined List' form by selecting an option from the 'Select DropDown Style' list: 

▪ Drop Down - Free form data entry. 

▪ Drop Down List - Predefined Text only. 

▪ System Default - Will be based on the setting in System Parameters. Note: Hover over this field to 
see the hint which describes these options as well as indicates the current global setting. 
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Select the Re-sequence (green arrows) button to sort the sequence alpha-numerically. 

Pick List Based - Check this option to make the list of choices to populate the user field with as a 
standard pick list rather than a drop down list. Note: Only the IQMS user can check this option. When this 
is checked the form will change to enter an SQL the system will use to create the pick list. Type the SQL 
in the field. Click the check mark button to verify the SQL. Next select which field will be used to 
populate the user field by selecting one from the drop down list in the 'Result Field'. The result options 
are based on the SQL. In the example below the options would be: ID, Division Name, or Description. 

 

Using the SQL in the screen shot above, the pick list would look like the example below and the field 
used to populate the user field is the Division Name (i.e. WHSE1). 
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Note: When a user creates a User Defined Form field and grants security to that UDF field, if the UDF field 
is deleted the security to the field is removed. If the UDF field is re-added with the same name, security 
will need to be reestablished for users. 

Designating User Fields to Populate Other User Fields on Insert 

It is possible to designate certain user columns to populate other user columns in the system with a 
trigger. The example trigger below allows user columns from selling AKA to populate user columns on 
the sales order detail. 

create or replace trigger ti_ord_detail  

before insert on ord_detail  

for each row  

declare 

  v_arcusto_id number; 

  v_ship_to_id number; 

begin 

  if :new.arinvt_id is null then 

     return; 

  end if; 

    begin 

    select arcusto_id, ship_to_id into v_arcusto_id, v_ship_to_id from 

orders where id = :new.orders_id; 

      select cuser1, cuser2, cuser3  

      into :new.cuser1, :new.cuser2, :new.cuser3 

      from aka 

     where arinvt_id = :new.arinvt_id 

       and arcusto_id = v_arcusto_id 

       and nvl(kind, '*') = nvl(:new.aka_kind, '*') 

       and misc.aka_ship_to_filter( v_arcusto_id, arinvt_id, 

v_ship_to_id, aka.ship_to_id) = 1; 

  exception when no_data_found then 
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    return; 

  end; 

  end; 

/ 
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Speed Buttons 

Speed buttons provide direct access to frequently used functions. For example, most forms support the 
ability to search for records. 

Search Button 

 The Search button is a common icon on many forms. These special pick lists allow a variety of ways 
to find the data of interest. (See Pick Lists below for details). 

Toggle Grid/Form 

  The Toggle Grid/Form button is on most forms and allows users to toggle the form from a table 
view to a form view. 

Printer Speed Button 

 In several modules there will be a printer speed button enabling users to print the specific report 
associated to the speed button. The set up for which report to print is done on the Reports and Forms 
tab in System Parameters. (See Reports/Forms for details). 

When using the speed button the From and To will default to the current record but can be changed 
using the drop down lists. The lists will only display records for the EPlant the user is logged into. 

From most printer speed buttons the 'Selection Criteria/Destination' form will appear. From some 
modules, i.e. Visual BOM Routing, only the Print form will appear. 

When available users can select the Destination. The choices are the same as when printing reports from 
the Reports menu (see Reports Menu for details). 

▪ Screen 

▪ Printer 

▪ File 

▪ Email 

▪ Fax 

When printing from the Printer speed button to the printer or email destination, documents set to 'Print 
With' the report will also print by default. To not have the 'Print With' documents print select the 
'Exclude attached documents' check box.  This is set per module and affects all users, not just the user 
logged in. This setting is remembered in the registry. 
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Note when Printing a Range - In several areas users can select a From and To Range to print. The data 
entered in the range is often alpha-character-based and not in numerical order (for example: invoice 
100-Paso would print before 2-Paso). If you try to print from 2-PASO to 100-PASO you will receive the 
error: ‘EnterpriseIQ error: Invalid range: ‘From’ must not be greater than ‘To’ (character based).’ 

From print screens throughout EIQ where the form can be sent via Auto EForm (such as Packing Slips) 
users will see the following print options: 

▪ Send Auto Email Only. Do not Print Report - This option can be checked when using the Auto EForm 
option to automatically email invoices to contacts, where you do not want the actual invoices 
printed. Note: If the setting in System Parameters->AR Setup called 'Auto Email Invoices upon Batch 
Post' is checked the auto email will not be sent until the invoice is posted. A message will display on 
the Print Prepost Invoices screen indicating this, 'Auto Email Invoices upon Batch Post (in System 
Parameters) is set to 'Y' report will not be Auto Emailed.' Note: Auto EForm will be sent to the 
contact(s) associated to the Ship To and any other contacts(s) in the main Contact tab not associated 
to any Ship To's. If a user is manually creating AR Invoices and selects two or more packing slips with 
different Ship To's then the Auto Eform will only select the contact for the first Ship To. Also note: An 
AR Invoice can only be sent to a 'Ship To' type contact if the 'One Invoice per Packing Slip' is selected 
in Auto Invoicing for the customer. So it is recommended that if users create Invoices manually, one 
invoice per packing should be done like Auto Invoice. 

▪ Print Only. Do not Auto Email - This option will only print the invoices. It will not email them. 

▪ No option selected - When nothing is checked the system will print and email the invoices (as long as 
they are set up for auto EForm). 

In AR Invoices and Customer Statements there is another option available: 

▪ Selective auto email print - With this checked the forms for customers with auto EForm set up will 
only be emailed, the statements for customers without auto EForm will be printed.  

In Packing Slips there is another option available: 

▪ Silent Print - This option is available if ‘Send Auto Email Only, Do not Print Report’ is checked. If this 
option is checked, the system will suppress the ‘This PS has been printed X times do you want to 
regenerate it’ prompt for every packing slip being auto emailed. 

Saving to a File 

When printing a report from a printer icon, and saving to a file on the destination tab, users have the 
option of creating their own file naming scheme and selecting the File Directory. Each module needs to 
be setup individually since the system needs to know which tables and columns to use. Click the ellipsis 
in the File Name field with the pop up hint of ‘click the button to specify the file naming formatting or 
enter the file name directly’ which opens the Format File Name screen. The separator used is a dash 
between format selections. Use the arrows to select the desired settings. You can also drag and drop 
them between Available and Selected, or move them up or down in the list. If desired, select the File 
Directory by clicking the Browse button. If a directory is not selected, it will default to the Master Home 
Reports directory. When satisfied with the file format settings, press the OK button. Please note: Reports 
that do not contain unique IDs, such as the default Certificate of Conformance report (C_of_C.rpt), are 
not compatible with the Number Format Type. Please utilize another Format Setting, or assign a path 
and name in the File Name field. 
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The pop up hint over the ellipsis will now read ‘User defined file name formatting is found. Click the 
button to review the formatting.’ When using user defined file naming, the files will be saved in the 
reports master home. If user defined file naming is setup, Auto EForms will utilize the naming convention 
and the title of the email will be the specified user-defined file name.  

Properties button - The properties button lists the default report associated to the printer speed button. 
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Select the Folder button to change the assigned default report. The list of reports will appear to choose 
from.  This will also change the default report listed in System Parameters->Reports and Forms tab for 
this button. The green arrow button will assign the default report automatically. 

The Execute Before Report field is used when a pre-written procedure should be run before the report is 
processed. For example: In order to get an accurate schedule report EIQ runs a procedure to update the 
date on all of the work centers. 

Security can be place on this button to prevent users from changing the default report. 

Note: Although security is unique for each print form within each module, the ‘BtnProp’ security item is 
the same throughout the system.  This means that if a user has any role with permissions enabled to 
BtnProp in any print form, then they will have permissions to it everyplace in the software.  For the EIQ 
stock roles, only the IQALL role has been given permissions to the Properties button.  The 
IQALLREPORTS and all applicable RO/RW roles have permissions to the print forms, but no permissions 
granted to the Properties button itself (neither visible or enabled). 

Add 'TO' Address - From the Email tab next to the 'To' field there will be a search button. When selecting 
the Add 'TO' Address search button the user will have a choice to add from the pick list, or add from the 
vendor or customer name (depending on the document). 

▪ Add from Pick List - This option will open a form for the user to choose the address list to select the 
recipients from (Customer, Partner, Vendor and Employee contacts as well as Outlook contacts). 

▪ Add from 'Principal' - This brings up a pick list of just the contacts associated to the vendor or 
customer depending on the document being printed. For example, when printing a purchase order, 
the Add from option will list the vendor associated to the PO (such as "Add from 'VEN##"). If the user 
selects a range in the From/To, the system will default to the Vendor of the first PO.  

Boiler Plates and User Signature 

Another difference when printing from a speed button versus a report menu report is on the Email tab 
from a printer speed button report users can set up and utilize Boiler Plates. The boiler plate description 
will populate the email subject line if a subject is not already populated, and the boiler plate body text 
will appear in the body of the email. 
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Select the Boiler Plate speed button and choose View/Edit to create a new boiler plate that can be 
selected when emailing the specific report. Select the insert (+) button and enter a Description and the 
actual text to be displayed in the body of the email. Spell check can be accessed either by pressing F7 or 
by right clicking and selecting 'Check Spelling.' 
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To use Boiler Plates, click the Boiler Plate button and then select Load From Boiler Plate.  A pick list of 
boiler plates associated to the specific speed button will display. The text associated to the boiler plate 
will populate the body area. This information can be edited prior to sending the email. 

Access to viewing and editing all types of Boiler Plates is accessed from System Parameters->Options 
menu->Boiler Plates Maintenance. Note: This type of Boiler Plate is only created directly from the Email 
destination tab of the specific module. These cannot be created from the Boiler Plates Maintenance 
module but can be edited from there. The speed button Boiler plate is hard coded with the type coming 
from the form. For example, when printing/emailing a sales order acknowledgement to a customer the 
type is hard coded to 'TFrmPrintDocsOE_Ack', if you are emailing the sales order, the type is hard coded 
to TFrmPrintDocs_OE. Only the boiler plates associated to the form will be visible in the pick list when 
emailing a report.  

Add a User Signature 

From the Boiler Plate button select User Signature. Enter up to 2000 characters in the pop up box. The 
text will display in the body of the email. If using boiler plates and user signatures when emailing a report 
from a printer speed button, the boiler plates will be inserted at the top of the email body, and the user 
signature is appended to the bottom of the email. If creating a user signature and the body of the email 
is already populated, users will receive a confirmation window asking ‘Add signature to the email body?’ 
Selecting yes inserts the new signature at the bottom of the email body, while selecting no does not 
insert the new signature. 

Note: The Outlook signature (including images) of the sender will automatically populate in the body of 
the email when reports are emailed when using the reports menu or from a speed button. 

Attachment Name - The user can also enter information in the Attachment Name field to override the 
default attachment name which is the report file name. 

Other Attachments - To send additional attachments select the 'Assign Attachment' button next to this 
field. Select the insert record button and then the ellipsis button in the field on the pop up form. Select 
the file to be attached to the email from the Open form. Additional attachments are added in the same 
manner. 
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Pick Lists 

EnterpriseIQ makes locating data easy by using pick lists of information throughout the program. These 
pick lists incorporate the ability to search the information on the screen in several ways so that you can 
find what you need as quickly and easily as possible. To change the search field click on the title of the 
column you want to search by, or right click anywhere within the pick list. A sub-menu will pop up giving 
you the search field options for this form. To change the search field, click on the field which you wish to 
search by. 

To further refine the search, begin typing information related to the field for the record you wish to find 
(such as the name, number, or description) on the search line. Then click on the ‘Search’ button to query 
the database for the appropriate record. A list of choices based upon the search criteria will appear. 
Scroll through the records using the scroll bar on the right or your mouse wheel. Other features added to 
the search function is the wildcard (%) or pattern search and the ( _ ) single character search. 

Example: 
If you type %ADV and select ‘Search’, the list will only show you those items with the letters ADV 
anywhere within the field. 

Note: The % function is only available on character fields (like char and varchar), not number fields such 
as ID's. For example it is not possible to use the % function when searching for a specific work order 
number in the work order pick list, PM work order pick list, or a pick ticket number in the pick ticket pick 
list because these fields are actually the record's ID. The pick list will populate with everything as if it was 
a blank search. If an entire work order number or pick ticket number (ID) is entered in the search, that 
record will be highlighted and the pick list will display records from that one forward. 

Exact Match - Check the Exact match check box to find the exact match of what was entered in the search 
field. This is not available for CHAR fields. This check box defaults to not checked but is remembered in 
the registry per pick list.  Note: There is not a global option in System Parameters for this check box. 

Note: By default all searches are case sensitive, but the user can override this on an individual pick list by 
selecting the Case insensitive option. When this is checked the system will also ignore the case for 
sorting within the columns. This setting is retained after a software update. There is also an option in 
System Parameters->Company File Information->Application section called 'Pick Lists are case 
insensitive'. If this is checked all pick lists in the system will ignore the case when searching. Also, the 
'Case insensitive' check box will not be visible on pick lists.  

Note: When searching for a date it is suggested the user enter the whole date. If you enter 10/30/2009, 
the pick list will return records for 10/30/2009 and every day after that, but if you enter 10 you will get 
everything.  This is due to the select statement in the pick list.  

Note: The system will remember whether the sort order is in ascending or descending order. 

Note: WebIQ and EIQ desktop versions each remembers the users settings separately. For example, if the 
user has a pick list sorting by Customer # in the desktop version, it does not carry over to the web 
version, and vice versa. 
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Upon finding the appropriate record, it is opened by “double” clicking the left mouse button or by 
choosing “Select” from the bottom of the display screen. Choose “Cancel” to de-select your entry and 
return to main entry screen. 
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If the wrong entry is selected, just return to the pick list. The pick list will remember the last entry or 
search made. This allows you to find data with a minimum of keystrokes. 

Multiple Sort Criteria 

The capability to select multiple sort criteria on many pick lists is available. If the pick list has this 

capability there is an icon in the upper right corner of the pick list next to the search button . When 
dragging the mouse over this button a hint box will display showing the current sort. To change the sort 
click on the button and the following screen will appear: 
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Select the available fields to sort by from the left grid and arrow them over to the right grid in the order 
of columns that you would like to sort on. Fields can also be moved from one section to the other by 
double clicking the item. The highlight column bar will always be on the first field selected. Then select 
search and the grid will be sorted based on the users criteria. This information will be retained (it is 
stored in the registry).  

Note: Calculated fields cannot be sorted, therefore they will not be listed as Available for sorting. 

Save Sort Criteria - Multiple sorts can be saved for future searches by selecting the drop down arrow next 
to the sort button. This will open the Sort Criteria pick list. Select the + button and enter a name for the 
current sort criteria in the pop up box. Then select OK. 
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The sort will be available to choose from by selecting the drop down arrow and selecting it from the list. 
Saved sorts can be deleted by selecting the minus button on the pop up form. 

Advanced Search Filter 

Each pick list has the capability for advanced filtering. Select the Advance Filter button  and a form 
will display from which the user can select specific fields to search on. 
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Highlight a field on the left side of the form then enter in the search values either on the By Value tab or 
the By Range tab. Multiple values can be entered in the Field Value field using an 'or' between records. 
Also, multiple fields may be selected. Then specify how the field value should be compared by selecting 
one of the options: Exact Match, Partial Match at Beginning, or Partial Match Anywhere. Users can also 
specify if the search should be Case Sensitive or to show the non matching records instead of the ones 
that match. Once all of the data is entered select the OK button and the pick list will bring back only the 
records that match the entered criteria. 

For example, if the user wants to see the list for all customers with a Cust # in the range of A - J that are 
in California and Colorado the form would be filled in as above. Choose the Cust# field and enter a and j 
in the By Range tab, then select the State field and enter CA or CO on the By Value tab. The View 
Summary button will display the search selection chosen: 

 

The pick list will display the advanced search filter details at the bottom. 
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Note: Type NULL into the field filter to view only records where the field is blank. 

Note: This does not apply to grid-type pick lists such as Workforce > HR Employee Maintenance. 

The advanced search will be remembered on the workstation until cleared. To clear the advanced search 

select the ‘Remove Advanced Filter’ button .  

Save Advanced Search Filter - When a pick list has an advance filter set, the Advanced Filter can be saved 
by selecting the drop down arrow next to the advanced filter button. This will open the advanced filter 
pick list. Select the + button and enter a name for the current filter in the pop up box. Then select OK. 
The filter will be available to choose from in future searches. To delete a search, select the - button from 
the pick list. 
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If a user attempts to saved an advanced filter but one was not assigned (the pick list is currently not 
advanced filtered) a message will appear stating, 'Advanced Filter is not assigned. Assign Advanced Filter 
and try again'. 

Filter Dataset in Forms 

This option is also available in some component forms throughout the system such as VMI, Auxiliary 
Equipment in BOM’s and Quotes, and Security Inspector. The functionality is the same as above. 
Additionally in these component forms users can define the order in which they see fields in the form. 

Show Hide User Defined Record View 

There is a button next to the Filter Dataset button called Show/Hide user defined record view . This 
view shows the data in a form versus the grid. Click on this button to open the defined record view. Next, 

select the Change record view layout button . A form will appear from which the user can change the 
order of the fields and add user defined labels as additional fields or as sub fields. 
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To Design the record layout select from the available fields on the left and arrow them over to the right. 
Use the buttons or right click to add additional Items (fields) or Sub Items. When adding a new item the 
user can right click and select Edit Label to change the name of the user defined label. The user defined 
labels can be used as header records to further define the view of data. (Data cannot be entered in the 
user defined label field). 

Once created the user can view the records using their designed record layout. To hide this layout click 
on the Show/Hide button to toggle it back to the default view. 

Note: The fields next to these labels are not available for data entry. 

Inactive Items 

 At the top of all pick lists is a toggle button which will switch the pick list to search for active items 
or inactive items. 

Component Where Used Search 

 The option to create component where used searches is available on the following pick lists: 
Inventory, Inventory Availability, BOM, Sales Orders, and the Inventory picklist in CRM Sales Quotations. 
This allows users to create a query to display parent items that involve all of the listed components. In 
Inventory and Inventory Availability the pick list shows all parent items in the BOM Tree that involve the 
components. In the BOM pick list it shows all BOMs that produce parent items in the BOM Tree that 
involve the components. The Sales Orders pick list shows all Sales Orders that include a parent item in 
the BOM Tree that involve the components. 

To create the Component Where Used Search click on the button on the pick list.  
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Select the insert record (+) button in the top section and enter the Filter Description.  

In the lower section select the insert record (+) button to add a row then click the ellipsis button in the 
Item # field and choose an item from the master inventory pick list. This list will display items from all 
EPlants. Continue entering the desired components. The filters will be available in all of the pick lists with 
this option. 

To use the search, highlight it in the list then select OK. The pick list will be filtered to display records 
with the components in the BOM Tree. For example, using the screen shot above, the BOM pick list 
would display only records that have both the listed carton and divider in the BOM Tree. 

Exclude Same Items in Other EPlants - This option can be selected from the File menu of the Select 
Component Where Used Filter screen.  If not checked, when adding a Component to the search setup, 
the system checks for the same item in other EPlants (based on Item #, Rev, Class) and adds them all at 
once, with the And/Or option set to OR so that all of the like items are used in the search. If this option is 
checked the system will just add the selected item, excluding the items in other EPlants. 

Select the Clear button to turn the filter off. The mouse over hint will display if the filter is off or on and 
which filter is being used. 

Propagate Sort & Scope 

Both of these options are found on pick lists throughout the system. 

Propagate Sort - With this checked the system will order the records in the module according to the 
column selected. For example, on the inventory pick list if the Item# column is selected and the user 
checks the Propagate Sort box, when the users scrolls using the navigator buttons in the module, the 
order will be based on Item #. 

Propagate Scope - With this option checked the module scope will be limited to the records in the pick 
list. For example, on the inventory pick list, if the Class column is selected and the user has 
searched/filtered for only class PL, when the users scrolls using the navigator buttons in the module only 
records with a class PL will be available. Essentially it narrows the records visible in the module based on 
the records visible in the pick list. 

Note: Some fields cannot utilize the Scope feature and if the column header is selected, the Scope 
checkbox will become disabled.  

Right Click Options 

The right click menu on a pick list will display all of the available fields to sort from. In addition to the 
fields there are two options: 

▪ Export Data - This option allows the user to export the data currently in the pick list to a XML file or 
an Excel file. The primary table ID will be added as the last column in the spreadsheet if the ID exists 
in the pick list query. Note: Exporting data to Excel format requires Microsoft Excel installed on the 
computer. If it is not installed this option will not be available. 

▪ Count - This will display the current pick list record count. Note: If the pick list has been filtered by 
using the Advanced Search button this message will appear: “Due to existing filter condition the 
count may take several minutes. Are you sure you want to continue?” 
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Pick lists wait for Prompt 

There is an option in System Parameters on the Company File Information->Application tab called ‘Pick 

lists wait for Prompt’. If this is selected all of the information in the pick lists throughout the system will 
not automatically come up until prompted. This can be a time saving feature as the pick lists grow. The 
overall Oracle server and network load can be reduced dramatically. The load reduction comes from the 
removal of all the initial queries that take place as the pick lists come up with all rows. As a general rule, 
the more rows a query returns the more server / network load it consumes. If the server gets bogged 
down processing pick list queries everything slows down. 

Note: If the 'Pick Lists wait for Prompt' option in System Parameter is not checked, each pick list will have 
this option available for an individual setting. With this box checked the pick list will not populate until 
the search button is selected. This can be a time saving feature for large pick lists. This setting is retained 
after a software update. 

Alt F1 in Pick Lists 

In pick lists user can select the Alt F1keys to view the the script being used by a pick list. 
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Form View/Table View Toggle 

 The Form/Table toggle icon allows you to toggle between two different screen views. Form view 
shows all fields for a single customer record, but is limited to viewing only one entry at a time. The Table 
view mode allows several entries to be viewed concurrently, but does not allow all information 
contained in each field to be viewed. 
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To view or make changes from within the Table view, use your “tab” or “arrow keys” to move to the 
desired cell(s). When finished viewing, simply click on the toggle button to return to the Form view. 

Keyboard short cut equivalents 

Below is a brief listing of some keyboard short cut equivalents based on general keyboard functions 
throughout the system: 

General Functions throughout the system: 

▪ Using the ALT key plus whatever letter is underlined in the menu list will bring up that module. This 
can be used in combination with the arrows and ENTER key to select from the menu options. 

▪ In most fields F2 will allow you to edit it (like in Excel). 

▪ In several accounting modules such as Accounts Payable and Cash Receipts the F2 button will cycle 
between the sections. 

▪ To open a hyper browse list type in any alpha/numeric key, depending on what kind of list it is. 

▪ TAB moves you from field to field. 

▪ SHIFT TAB takes you backwards through the fields 

▪ ALT F4 exits out of a screen (closes it). Note: On warning pop up forms with security ALT F4 will not 
close the pop up. 

▪ ALT F6 brings the main launcher bar to the forefront 

▪ SHIFT F10 - is to right click. 

▪ Space bar will check / un-check a box. 

▪ For all Pick lists that are not hyper browse, use TAB to get from search criteria line to the list that 
comes up. You can also use arrows to move up and down the list and ENTER to select line item that is 
highlighted. 

▪ ESC will exit out of pick lists. 

▪ Using the down arrow will add a new line item to certain sections. 

▪ TAB will also add another line item when you tab to the end of a line. 

 

Closing EnterpriseIQ 

To exit EnterpriseIQ, click on the X in the upper right corner, or select Exit or Close from the File menu. If 
changes were made without posting the edit when closing the BOM, Inventory, Sales Order, PO or 
Requisition forms, users are prompted with message “Save Changes?” and Yes/No buttons.  This 
applies when selecting the X and with File > Exit (or Close) selected. 

Exiting out of EIQ Launcher Bar automatically logs you out of the system and database and will close all 
open EnterpriseIQ applications. 

NOTE: Failure to log out properly leaves your system open for anyone to access the EnterpriseIQ screen 
modules from your computer. For security purposes, you must make sure to log out before leaving. 
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NOTE: The X in the upper right corner typically will also close pop up forms, however on warning pop up 
forms with security the X is disabled to force users to select the Yes or No button. 
 

Drop Down Calendars 

Throughout the system there are date fields that are entered/edited using a drop down calendar. From a 
date field select the arrow down button. The first time a date field is entered the calendar will default to 
the system date which will be circled: 

 

To change the date simply click on the desired date with the mouse. To move to a past or future month 
use the arrow back or forward buttons at the top. To select a specific month or year click on the month 
text or year text and choose the month or year. 

 

Note: The majority of date fields in the system can have a time added by using the right arrow. 

Date Display 

It is highly recommended that your computer be configured to always display date fields in the following 
format: MM/DD/YYYY (02/02/1999). You can set your Windows based computer to default to this 
display. 

1 Open the Control Panel, and locate the Regional and Language icon 

2 Open the Regional icon, locate and click on the Formats tab 

3 From within the Short Date box, use the drop down list to change the Short Date Style value to 
mm/dd/yyyy. 

4 Press Apply and /or OK to save this setting. 
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With this setting in place, all dates will show the full year. 

Note: The above format is recommended, however EnterpriseIQ desktop version has validated the 
following short date formats: M/d/yyyy, M/d/yy, MM/dd/yyyy, dd-MMM-yy.  

Note: The dd-mmm-yy date format is not recommended in version 16 of WebIQ.  
 

Note Fields 

Throughout the system there are areas where users can add notes. These note fields use the IQEditor, 
which is a pop up form to enter the specific text relevant to the field. For example, there are three of 
these types of fields in inventory: SO Item Information, PO Item Information, and Receiving Information. 
Users can enter specific text that will pop up when a user creates a sales order or PO for the item, or 
receives the item. 
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The form will display the Text Length available at the bottom left, and as text is entered it will be 
updated with the character and word count. Once the text is entered select the OK button to save and 
close the form. The text can also be printed by selecting the Print button.  

If a user attempts to enter more than the allowed text length an error will display stating: "General SQL 
error. Value too large for column..." 

Note: Selecting the 'F5' keyboard button will add the current date and time to the text. 

Right Click Options: 

▪ Copy - Copies the text  

▪ Paste - Pastes the text 

▪ Cut - Cuts the text 

▪ Check Spelling - Select the 'Check Spelling' option and a form will appear displaying any misspelled 
words with options for corrections, additions, and changes. 

 

▪ Select All - Select all the text 

▪ Print - Prints the text 

▪ Save to File - Saves the text as a .txt, rtf, or doc file to a selected location. Once saved the system will 
ask if the user would like to open the file. 

▪ Save and Close - This will save and close the form. 

▪ Remove Extra Line Breaks - Removes any extra line breaks. 
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IQArchiver 

The IQArchiver module enables users to archive Sales Orders, Purchase Orders, Translog, and BOL 
records from one convenient location. To access this module select the IQArchiver button from the 

System Setup tab on the launcher bar . 

 



Using EnterpriseIQ - Basic Functions Page 123 of 134 

 

The first step is to select the archive activity from the Action List (Sales Orders, Purchase Orders, or 
Translog). 

Archiving Sales Orders 

Sales Orders can be archived in batches from the IQArchiver module on the System Setup tab. A pop up 
form will appear where the user can select the 'Exclude Orders Shipped After' option and enter a date in 
the Last Ship Date field (manually type the date or select it from the drop down calendar). This will 
exclude any orders shipped after the entered date. Select cancel to return to the archive batch screen 
with no records marked.  Select OK to continue and the system will evaluate which sales orders can be 
archived. This is based on the shipped after date if applicable, and if the blanket quantity of each line 
item has been shipped in full or is within the designated “Short Within%” set in System Parameters-
>Purchase order and Sales Order Setup. A message will appear: ‘Finished marking orders that are fully 
shipped or short within x.xx%. Number of orders marked: xx’. A screen will also appear with the sales 
orders to be archived marked in blue: 
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The sales order(s) the system has marked will also have the ‘Can Be Archived’ box checked. This box is 
read only and cannot be manually checked. The user can de-select orders or select other orders by 
manually highlighting the desired orders using the toggle buttons or keyboard. Once the user manually 
makes a change to this form all of the orders the system automatically marked will no longer be marked 
blue. To have the system re-evaluate the sales orders the user can select the ‘Mark orders shipped in full 

or short within x%’ button  to automatically remark the orders that can be archived. Selecting this 
option will also bring up the 'Exclude Orders Shipped After' date option. Once the desired orders are 
marked select OK. A warning will appear: ‘About to archive and delete xx sales orders. Please confirm to 
continue’. Select Yes to continue and all of the selected orders will be archived. 

If a work order associated to the sales order is scheduled to run an ‘Authorization Required’ box will 
appear requiring the user to select OK to continue or Cancel to not archive the sales order. Depending on 
the user’s security they may not be able to select OK to continue archiving the order. 

The user can right click from this form and select ‘Jump to Sales Order’ to view the sales order prior to 
making a decision to archive it. 

Note: When data is archived it is moved from one table to another such as orders to hist orders. The 
data is moved but it does not free up any space in the table it was moved from (there is still a high 
watermark). So the tables must be compressed which removes the watermark. In order to compress the 
files an IQAlert should be set up to perform this compression during low traffic times. To compress Order 
Entry (OE) tables please use: begin iqcompress.do_execute_ex('RELEASES;ORD_DETAIL;ORDERS'); end; 

Archiving Purchase Orders 

Multiple purchase orders may be archived at a time as long as they are closed. Select the Purchase 
Orders archive activity. 
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The user has the option to include uninvoiced PO’s by checking the box. This feature will allow archiving 
of PO’s with uninvoiced receipts. 

Choose one of the options: 

▪ All Purchase Orders - Archives all purchase orders. 

▪ PO date no later than selected date - This option limits the POs to be archived based on the PO date. 
It will only include closed PO’s through a specified PO date. For example, if a date is specified of 
10/1/2001 the system will only archive closed PO’s with a date earlier than 10/2/2001. 

▪ PO Receipt Date no later than selected date - This option limits the POs to be archived based on the 
receipt date on the PO. It will only include closed PO’s with a receipt before the specified PO Receipt 
date. The system looks at the max receipt date for all items on the closed PO. 

Also this process can be limited to only include closed PO’s through a specified date. For example, if a 
date is specified of 10/1/2001 the system will only archive closed PO’s with a date earlier than 
10/2/2001. 

NOTES:  

For EPlant users: Only the PO’s with the user’s EPlant ID will be archived as long as the user is logged into 
that EPlant. If logged in as view all, all closed PO’s will be archived. 

When data is archived it is moved from one table to another such as orders to hist orders. The data is 
moved but it does not free up any space in the table it was moved from (there is still a high watermark). 
So the tables must be compressed which removes the watermark. In order to compress the files an 
IQAlert should be set up to perform this compression during low traffic times. To compress PO tables 
please use: begin iqcompress.do_execute_ex('PO_RELEASES;PO_DETAIL;PO'); end; 

Archive Translog 

Users can archive Translog based on a selected date.  This is not EPlant specific, it will archive 
transactions from all EPlants through the selected date. The form will display the earliest translog date. 
Enter the last date associated to translog records that should be archived in the 'Translog date no later 
than' field using the drop down calendar. Translog records will be archived up to and including the 
entered date. 
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These records will be moved from TRANSLOG and TRANSLOG_MASTER_LABEL to HIST_TRANSLOG and 
HIST_TRANSLOG_MASTER_LABEL. Historical data can be accessed via reports using these tables. 

Note: When data is archived it is moved from one table to another. The data is moved but it does not 
free up any space in the table it was moved from (there is still a high watermark). So the tables must be 
compressed which removes the watermark. In order to compress the files an IQAlert should be set up to 
perform this compression during low traffic times. To compress Translog tables please use: begin 
iqcompress.do_execute_ex ('TRANSLOG; TRANSLOG_MASTER_LABEL'); end; 

Archive BOL 

Bill of Ladings can be archived based on a date. This is not EPlant specific, it will archive BOLs from all 
EPlants through the selected date. Select the date from the drop down calendar that you would like to 
archive BOLs with a date before that date. Click on OK and all BOLs with BO date before the date 
selected will be displayed. Click cancel to return to the IQArchiver. 
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The grid will display the  BOL #, BOL Date, Ship Via, FOB, and Ship To. Use the toggle buttons to select 
the records to be archived. A right click option to Jump to the BOL is available. 

Once the desired records have been selected, select OK. The system will prompt the user with a message 
stating, ‘About to archive XX Bill of Ladings.  Please confirm to continue’.  Click Yes to archive the 
BOLs, if Cancel is selected no records are archived. 
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Event Log 

EnterpriseIQ sends all known system and process errors to the event log. The log includes the date/time, 
a brief description of the error message, and the user ID. The log serves two main purposes: 

▪ Detect errors within the data files. For example, if an order still exists for a part number that has 
since been deleted, the system will write this information to this file. By using this log on a 
continuous basis, you can fine tune the integrity of your databases. 

▪ Log code listings if an error is encountered during execution. Should the program fail during 
execution, DELMIAworks can often use this information to determine the cause of the failure. Either 
the code can be modified to avoid the problem, or the message will assist DELMIAworks in 
determining whether the network reported an error. 

The event log can be accessed from the File->System menu on the EIQ Launcher Bar. 
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The Event Log includes the following log classes: 

▪ Autoload 

▪ Autoinvoicing 

▪ Auto Fix Seq 

▪ Batch Date Change 

▪ Batch Rounding 

▪ CGI 

▪ DD Update 

▪ GLAcct 

▪ Inv Cost Parms 

▪ Inventory Trans 

▪ IQPM 

▪ Irv32 Diag 

▪ Irv32 Info 

▪ LBSK 

▪ Net Change 

▪ OE 

▪ Pallet Wrapper 

▪ PM Sched Update 

▪ PO 

▪ Prod Rep 

▪ PS 

▪ Rolltmptostd 

▪ RT Setup 

▪ RTServer 

▪ RTServer Debug 

▪ RT Shift Change 

▪ SO Batch Arch 

▪ Tag Inventory 

▪ Tax Services 

▪ Workflow Error 

▪ Workorder 

Select an Event Log Class from the drop down list. Enter a Date Range (from and to) then select the Apply 
button. The relevant records will be listed with the date/time and user ID. Specific event information will 
display on the right side of the form. The information can be printed by selecting the Printer button. 
Select the Purge button to purge the data based on the from and to date range entered in the pop up 
form. 
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DELMIAworks support staff may ask that the event, or portions of the event log, be provided for review 
and analysis. 
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